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Overview 

 

The Data Exchange for Sage 200 module provides an out of the box solution enabling 

integration between Sage 200 and 3rd party applications. Many businesses that use Sage 

200 have requirements for integration with other systems. The following few examples are 

typical scenarios: 

 

 Web trading – making stock information including descriptions, pricing and pictures 

available on a website, and receiving sales order information. 

 Bespoke stock management systems – companies using industry specific systems to 

handle stock and order processing where stock movements need to also be accounted 

for in Sage 200. 

 EPOS systems – companies using an EPOS system other than Sage POS where sales 

order and cash transactions need to be posted to Sage 200. 

 Global enterprises – where different parts of an organisation use different 

accounting/business management solutions and require customers, suppliers and 

various transaction types to be synchronised between systems. 

 

In the above situations, the typical solution is to write complex and very costly data transfer 

routines to handle movement between different database types. Often this can result in large 

administrative overheads in transferring the data, and discrepancies occurring between 

systems as a result. Data Exchange for Sage 200 has been designed to account for these 

scenarios and many more. 

 

Main Features and Benefits: 

 

 Easy to install and configure - easy to follow install wizard and simple configuration. 

 Automated standard import routines – Data Exchange allows for the standard Sage 

200 import routines to become automated, cutting down on the amount of time spent by 

users transferring data manually. 

 Additional import routines – As well as automating the standard import routines, Data 

Exchange also allows for Sales Orders, Purchase Orders and Cashbook transactions to 

be imported. 

 Supports CSV and XML file formats – data can be transferred in and out of Sage 200 

in either CSV or XML formats, allowing more flexible integration with different databases. 

 FTP/sFTP compatible – Upload Sage 200 data to designated locations on an FTP or 

sFTP site, particularly useful for web integration. 

 Further customisation potential – If additional import/export routines are required, we 

can write these for you. 

1. System Requirements 
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The Data Exchange has the following requirements: 

 

• Microsoft Windows Vista or later operating system. 

• Windows Server 2008 or later (run as administrator).  

• Sage 200 v2010, v2011, v2013 SP1, v2013 R2 or v2015 On Premise 

 

It is recommended that Sage is updated to the most recent Service Pack for your version. 

 

NOTES 

• For v2013 (all versions) and v2015 only the On Premise version is supported at this 

time. 

• For v2013 (all versions) and v2015 the “Enforce Logon” option must be disabled in 

the Sage System Administrator. 

2. Installation 

 

The Data Exchange utility can be installed on any machine which has the Sage 200 client 

software installed.  

 

To begin the installation of the Data Exchange for Sage 200, double click the setup.exe file. 

 

If SQL Server Compact 3.5 is not installed on the machine, this needs to be installed before 

continuing. The following screen will appear prompting you to accept the terms and 

agreements of this software. As it is required for the Data Exchange to work, users should 

click "Accept" to continue:  

 
 

Once SQL Server Compact has installed, the installation process for the Data Exchange will 

begin and to continue, click "Next” on the following screen which appears: 
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Click ‘Next’ to accept the default installation path and install for all windows users, or click 

‘Just Me’ if you would like the utility to be visible to the currently logged in user only: 

 

 
 

Click ‘Next’ to confirm the installation. 

 

 
 

Finally, click ‘Close’ to complete the installation. 
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Before using the Data Exchange utility you must set up a user in the Sage 200 System 

Administrator for the import to use with access to the company you will be using with the 

utility. This user should be added to a role that has “Remote Users Access Only” enabled so 

that it does not take up a user license.  
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3. Licencing 

 

When you first install the Data Exchange application, the installer will automatically apply a 

30 day demo licence.  In order to get a full licence you will need to obtain a licence file from 

your Sage 200 Business Partner. You can obtain a licence by choosing Help > Licence 

Details to reveal your licence request code along with the expiry date of your current licence.  

 

Please quote your request code along with the name of the company when contacting your 

Sage 200 Business Partner.  

 

 

You will then be sent a licence file which needs to be saved in the C:\Program Files 

(x86)\Eureka Solutions\Data Exchange folder (or in the location where the Data Exchange 

has been installed if you have chosen to install this in a different location). The Data 

Exchange must be restarted for the new licence to apply. Once the expiry date on your 

licence key is reached you will be unable to use the Data Exchange for Sage 200 until a new 

licence key has been obtained. 
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4. Configuring Program Settings 

 

4.1 Configuration Settings 

 

Before starting the Data Exchange for Sage 200 for the first time you must configure the 

program settings. Run the application by choosing "All programs" > "Eureka Solutions"> 

"Eureka Data Exchange" or double click the icon on the desktop. The following message 

may appear: 

 

 
 

The application needs to run as administrator so click "Yes" to continue and start the Data 

Exchange. It will initially run on the main screen with the "Start" and "Stop" buttons disabled. 

This is because the application has not yet been configured and the status bar informs the 

user that the default folder locations have not been specified: 

 

 
 

When using the Data Exchange for the first time, the program settings must be configured. 

Select "Edit > Global Settings" to enter the import settings: 
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On the General tab you must enter folder locations for where the processed files are to be 

stored.  

 

When Data Exchange successfully imports a file into Sage 200 it will move the original file 

from the import location to the Posted Files folder specified in the settings. If a file fails to 

import, the original file will be moved out of the import location into the Failed Files folder. 

Users can then see which files have failed and amend these as required to be reimported. 

 

You can also specify how frequently the Data Exchange should run the import routines by 

selecting how often it should check for import files. Export routines will also run at this time. 

The Data Exchange can also be configured to start looking for files to import as soon as the 

program is loaded by ticking the Auto Start on Opening checkbox. 

 

On the General tab, there is also a setting for retaining the original prefix of the filename 

when the file is moved to the processed folders. The name will be retained and extended 

with posted or failed followed by a timestamp. The original name will be retained if the Keep 

Original File Prefix checkbox is checked. For example, the import fileTestImport.csv would 

be renamed to TestImport_Posted_121207_171735. 

 

The Split CSV files option also allows for CSV import files to be automatically split into 

batches. E.g. if maximum is set to 500 lines, the original file will be split into batches of 500.  

When a file is split it will have _split_XX (where xx is an incementing number) appended to 

the file name.  Any files containing “_split_” in their file name will be ignored by the file splitter 

as it is assumed they have already been split. 
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The Only Import files that exist when import run starts option can be used when you 

have a 3rd party system that creates batches of files that you need to be imported in a 

specific order.  If files are added to the import folders while Data Exchange is part way 

through an import run, these files will be ignored until the next time Data Exchange starts an 

import run.  

 

The FTP tab allows you to setup multiple FTP or sFTP locations which the Data Exchange 

can use to Import/Export all files types. The FTP user must have read/write access on the 

FTP (or sFTP). The test button should be clicked to check the Data Exchange can 

successfully connect to the FTP (or sFTP) site. 

 

 
 
NOTE:  Data Exchange supports either FTP or sFTP (SSH File Transfer Protocol).  It does 
not support FTPS (FTP over SSL) at this time. 
 

The SMTP tab allows you to setup an email notification which contains statistics of the files 

imported/exported. This contains a summary of all the import / export activity. 

 

 
 

You should contact your IT Support to obtain the required FTP/sFTP and/or SMTP details. 
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4.2 Sage 200 Connection Settings 

 

To enter the Sage 200 company and log on details to use with the Data Exchange, select 

"Edit > Plugin Settings" from the menu bar and on the screen, select "Sage Data Connection 

> Sage  200 Connector": 

 

 
 

The login details and company where the data is to be imported / exported must be entered 

within this screen.  Enter the logon detail and click Test.  If successful you  can then select 

the Company to connect to.  Note that only companies the supplied user has access to will 

be available. 

 

NOTE:  For sage 200 v2013 / v2013 R2 / v2015 no UserName/Password are required.  Data 

Exchange will connect using the current logged in Windows User.  You should ensure that 

the User account has been given access to the appropriate companies in the Sage System 

Administrator. 

 

If the multiple company functionality is being used, the company details and login details 

should be entered per company. You must ensure the login user has access to the company 

being used. The default company can also be selected on this screen: 
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The test button should be clicked to ensure the Data Exchange will be able to connect to 

Sage 200 with the details entered successfully. Once the company details have been 

entered / amended, the Data Exchange must be restarted.  

 

4.3 Import / Export Plugin Settings 

 

Once the connection settings have been made, the import and export settings can be 

specified by selecting Import Plugins and Export Plugins and selecting the import and 

export routines you wish to run. To enable an import plugin, select the Plugin Enabled 

option and specify the location of the Import file or FTP location. If the Multiple Company 

feature is enabled, the company can also be selected.  

 

 
 

Specify Column alias allows you to use your own names for the column headers in the 

CSV/XML file.  Simply enter your own value into the Alias Name column.  Note the Alias 

name must be unique in that it cannot match another Alias or another Standard Name. 
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To enable an export plugin, simply check the Plugin Enabled option and specify a location 

to save the export file. You can choose whether the export file is in CSV or XML format and 

specify FTP setting if you wish to use them.  You can specify what gets exported by 

specifying the export type.  On the Column Aliases tab, you can also select which columns 

are included in the export. You can also specify your own column header names similar to 

the Import plugins. If the Multiple Company feature is enabled, the company can also be 

selected. 

 

 
 

4.4 Importing / Exporting Plugin Settings 

 
A backup copy of the plugin settings can be exported by selecting Edit> Export Settings to 
File.  
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An export location should be selected and clicking the Export button will export the settings.  
 
The plugin settings can be imported by selecting Edit> Import Settings from File. 
 

 
 

The import location of the settings files should be selected and then imported by clicking the 
import button.  
 

5. Program Operation 

 

Once all settings have been entered the Data Exchange utility is ready to run. Simply click 

the Start button to begin the process. 

 

 
 
Once started the data exchange will go through each enabled plugin one by one importing or 
exporting as appropriate.  Once finished it will wait the length of time specified in the general 
settings before starting its next run. 
 

The Stop button will stop the Data Exchange after the current import / export has been 

completed.  

 

The Data Exchange for Sage 200 is capable of importing an array of different import types. 

Section 4.3 explains how the individual import / export routines can be enabled. For each of 

the enabled plugins the application automatically searches the defined paths for import files - 

these files can be in CSV or XML format. Once an import file is posted to 200 it is renamed 
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appropriately and copied to the location for storing posted files. If the import fails then the file 

is moved to the backup location for failed files and should be reviewed before attempting to 

import again. 

 

An import file can contain multiple transactions and the utility works on the basis that if 

validation fails for any of the transactions contained in a file then none of the transactions in 

that file are imported. For each file processed, a detailed report is generated which can be 

reviewed at any time, either from the main screen or by choosing View > History: 

 

 
 

On selecting a date, a form will be launched with a history of the imports / exports from that 

day. All individual plugin reports can be printed or saved to file if required: 

 

 
 

All CSV files created for use with Data Exchange should contain a first line with column 

headers for each field included in the CSV file. All XML files created for use with Data 

Exchange should conform to the standard Sage XML file format. There are examples of 

these in the templates folder of the program install location.  

 

The sales and purchase import routines imports work in exactly the same way as the 

standard Sage 200 import routines, whereas the others have been programmed specifically 

for Data Exchange. There are no existing standard imports in Sage 200 for these. It is 

therefore important to practice creating and manually importing sales and purchase ledger 

transaction files before using the Data Exchange on your live Sage 200 data.  
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5.1. Import Files 

 

The following Import file formats are intended as a guide only.  For the most up to date 

version please check the Templates folder in the Data Exchange installation directory. 

i.e. C:\Program Files\Eureka Solutions\Data Exchange\Templates. 

 

There should be a number of files there for each plugin.  The .doc file will contain the up to 

date version of the tables below. 

 

5.1.1. Sales Ledger Import 

 

This allows Sales Ledger Transactions to be imported into Sage 200. 

 

Field Name Format Required Import Rules 

AccountNumber Text, max 8 

characters 

Yes Must be a valid Sage 200 

Purchase Ledger Account 

CBAccountNumber Text, max 8 

characters 

No Must be a valid Cash Book 

account number. 

DaysDiscountValid Integer No  

DiscountValue Decimal No  

DiscountPercentage Decimal No 0 – 100  

DueDate dd/mm/yyyy No  

GoodsValueInAccountCurrency Decimal No  

SalControlValueInBaseCurrency Decimal No  

DocumentToBaseCurrencyRate Decimal Yes  

DocumentToAccountCurrencyRate Decimal Yes  

PostedDate dd/mm/yyyy No  

QueryCode Text, max 2 

characters 

No F - Finance Charges    

U - Unauthorised 

Transactions    

W - Write Offs    

Any other character - your 

own 

TransactionReference Text, max 20 

characters 

No  

SecondReference Text, max 20 

characters 

No  

Source Integer No 1 – Sales    

2 – Purchase    
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Field Name Format Required Import Rules 

3 – Nominal    

4 - Payroll (n/a)   

5 - Job Costing (n/a)    

6 - Stock Control   

7 – SOP    

8 – POP    

9 – Invoicing    

10 - Cash Book    

11 - BOM (n/a)    

12 - Fixed Assets (n/a)    

98 - Ledger tax    

99 - Ledger unknown source 

 

Note: You can use any value 

between 16 and 90 to 

indicate transactions 

originating from an external 

program other than Sage 

MMS. 

SYSTraderTranType Integer Yes Must be one of: 

1 - Sales receipt (SR) 

2- Sales payment (SP) 

4 - Sales invoice (SI) 

5 - Sales credit (SC) 

6 - Opening balance invoice 

7 - Opening balance credit 

note 

TransactionDate dd/mm/yyyy Yes  

UniqueReferenceNumber Integer No  

UserNumber Integer No  

TaxValue Decimal No  

SYSTraderGenerationReasonType Integer No 0 – Unknown (standard 

transaction)  

1 - Finance Charge Interest  

2 - Bad Debt Processing 

NominalAnalysisTransactionValue/1 Deciaml Yes  

NominalAnalysisNominalAccountNumber/1 Text, max 8 

characters 

Yes Must be a valid Sage 200 

Nominal Account Number 

NominalAnalysisNominalCostCentre/1 Text, max 3 Yes Must be a valid Sage 200 
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Field Name Format Required Import Rules 

characters Cost Centre 

NominalAnalysisNominalDepartment/1 Text, max 3 

characters 

Yes Must be a valid Sage 200 

Department 

NominalAnalysisNominalAnalysisNarrative

/1 

Text, max 60 

characters 

Yes  

NominalAnalysisTransactionAnalysisCode/

1 

Text, max 20 

characters 

Yes1 Must be a valid Sage 200 

Transactional Analysis Code 

NominalAnalysisTransactionValue/2 Decimal No  

NominalAnalysisNominalAccountNumber/2 Text, max 8 

characters 

No Must be a valid Sage 200 

Nominal Account Number 

NominalAnalysisNominalCostCentre/2 Text, max 3 

characters 

No Must be a valid Sage 200 

Cost Centre 

NominalAnalysisNominalDepartment/2 Text, max 3 

characters 

No Must be a valid Sage 200 

Department 

NominalAnalysisNominalAnalysisNarrative

/2 

Text, max 60 

characters 

Yes  

TaxAnalysisTaxRate/1 Integer Yes Must be a valid Sage 200 

Tax Rate 

TaxAnalysisGoodsValueBeforeDiscount/1 Decimal Yes  

TaxAnalysisDiscountValue/1 Decimal Yes  

TaxAnalysisDiscountPercentage/1 Decimal Yes  

TaxAnalysisTaxOnGoodsValue/1 Decimal Yes  

TaxAnalysisTaxDiscountValue/1 Decimal No  

TaxAnalysisTaxRate/2 Integer No Must be a valid Sage 200 

Tax Rate 

TaxAnalysisGoodsValueBeforeDiscount/2 Decimal No  

TaxAnalysisDiscountValue/2 Decimal No  

TaxAnalysisDiscountPercentage/2 Decimal No  

TaxAnalysisTaxOnGoodsValue/2 Decimal No  

TaxAnalysisTaxDiscountValue/2 Decimal No  

ChequeCurrencyName Text, max 30 

characters 

No  

ChequeToBankExchangeRate Decimal No  

ChequeValueInChequeCurrency Decimal No  

TriangularTransaction Integer No 0 or 1 

IsSettledImmediately Integer No 0 or 1 

TaxDiscountValue Decimal No  
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1. Nominal Transactional Analysis Code is only mandatory if they are enabled within 
Sage 200. 

 

5.1.2. Purchase Ledger Import 

 

This allows Purchase Ledger Transactions to be imported into Sage 200.  

 

Field Name Format Required Import Rules 

AccountNumber Text, max 8 

characters 

Yes Must be a valid Sage 200 

Purchase Ledger Account 

CBAccountNumber Text, max 8 

characters 

No Must be a valid Cash Book 

account number. 

DaysDiscountValid Integer No  

DiscountValue Decimal No  

DiscountPercentage Decimal No 0 – 100  

DueDate dd/mm/yyyy No  

GoodsValueInAccountCurrency Decimal No  

PurControlValueInBaseCurrency Decimal No  

DocumentToBaseCurrencyRate Decimal Yes  

DocumentToAccountCurrencyRate Decimal Yes  

PostedDate dd/mm/yyyy No  

QueryCode Text, max 2 

characters 

No F - Finance Charges    

U - Unauthorised 

Transactions    

W - Write Offs    

Any other character - your 

own 

TransactionReference Text, max 

20 

characters 

No  

SecondReference Text, max 

20 

characters 

No  

Source Integer No 1 – Sales    

2 – Purchase    

3 – Nominal    

4 - Payroll (n/a)   

5 - Job Costing (n/a)    



P a g e  | 20 

  

 

Field Name Format Required Import Rules 

6 - Stock Control   

7 – SOP    

8 – POP    

9 – Invoicing    

10 - Cash Book    

11 - BOM (n/a)    

12 - Fixed Assets (n/a)    

98 - Ledger tax    

99 - Ledger unknown source 

 

Note: You can use any value 

between 16 and 90 to 

indicate transactions 

originating from an external 

program other than Sage 

MMS. 

SYSTraderTranType Integer Yes 1 - purchase payment (PP)   

2 - purchase receipt (PR)   

4 - purchase invoice (PI)   

5 - purchase credit (PC)   

6 - opening balance invoice   

7 - opening balance credit 

note. 

TransactionDate dd/mm/yyyy Yes  

UniqueReferenceNumber Integer No  

UserNumber Integer No  

TaxValue Decimal No  

SYSTraderGenerationReasonType Integer No 0 – Unknown (standard 

transaction)  

1 - Finance Charge Interest  

2 - Bad Debt Processing 

GoodsValueInBaseCurrency Text, max 

13 

characters 

No  

NominalAnalysisTransactionValue/1  Yes  

NominalAnalysisNominalAccountNumber/1 Text, max 8 

characters 

Yes Must be a valid Sage 200 

Nominal Account Number 

NominalAnalysisNominalCostCentre/1 Text, max 3 

characters 

Yes Must be a valid Sage 200 

Cost Centre 
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Field Name Format Required Import Rules 

NominalAnalysisNominalDepartment/1 Text, max 3 

characters 

Yes Must be a valid Sage 200 

Department 

NominalAnalysisNominalAnalysisNarrative/1 Text, max 

60 

characters 

Yes  

NominalAnalysisTransactionAnalysisCode/1 Text, max 

20 

characters 

Yes1 Must be a valid Sage 200 

Transactional Analysis Code 

NominalAnalysisTransactionValue/2 Decimal No  

NominalAnalysisNominalAccountNumber/2 Text, max 8 

characters 

No Must be a valid Sage 200 

Nominal Account Number 

NominalAnalysisNominalCostCentre/2 Text, max 3 

characters 

No Must be a valid Sage 200 

Cost Centre 

NominalAnalysisNominalDepartment/2 Text, max 3 

characters 

No Must be a valid Sage 200 

Department 

NominalAnalysisNominalAnalysisNarrative/2 Text, max 

60 

characters 

Yes  

TaxAnalysisTaxRate/1 Integer Yes Must be a valid Sage 200 

Tax Rate 

TaxAnalysisGoodsValueBeforeDiscount/1 Decimal Yes  

TaxAnalysisDiscountValue/1 Decimal Yes  

TaxAnalysisDiscountPercentage/1 Decimal Yes  

TaxAnalysisTaxOnGoodsValue/1 Decimal Yes  

TaxAnalysisTaxDiscountValue/1 Decimal No  

TaxAnalysisTaxRate/2 Integer No Must be a valid Sage 200 

Tax Rate 

TaxAnalysisGoodsValueBeforeDiscount/2 Decimal No  

TaxAnalysisDiscountValue/2 Decimal No  

TaxAnalysisDiscountPercentage/2 Decimal No  

TaxAnalysisTaxOnGoodsValue/2 Decimal No  

TaxAnalysisTaxDiscountValue/2 Decimal No  

ChequeCurrencyName Text, max 

30 

characters 

No  

ChequeToBankExchangeRate Decimal No  

ChequeValueInChequeCurrency Decimal No  
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Field Name Format Required Import Rules 

IsSettledImmediately Integer No 1 or 0 

TaxDiscountValue Decimal No  

IsVATAdjustmentDocumentExpected Integer No 1 or 0 

 
1. Nominal Transactional Analysis Code is only mandatory if they are enabled within 

Sage 200. 
 

5.1.3. Nominal Ledger Import 

 

This allows Nominal Ledger Transactions to be imported into Sage 200. 

 

Field Name Format Required Import Rules 

AccountCostCentre Text, Max 3 

characters 

No  

AccountDepartment Text, Max 3 

characters 

No  

AccountNumber Text, Max 8 

characters 

Yes  

TransactionType Integer No Should be 1 or left blank. 

TransactionDate dd/mm/yyyy Yes Defaults to Import Date if left 

blank. 

GoodsAmount Decimal Yes Cannot be zero 

Reference Text, Max 20 

characters 

No  

Narrative Text, Max 60 

characters 

No  

UniqueReferenceNumber Integer No  

UserNumber Integer No Must be a valid user number 

in Sage System 

Administrator.  If left blank it 

will default to the User used 

by Data Exchange. 

Source Integer No This indicates the module 

the 

transaction originated from. 

1 - Sales 

2 - Purchase 

3 - Nominal 

4 - Payroll (n/a) 
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Field Name Format Required Import Rules 

5 - Job Costing (n/a) 

6 - Stock Control 

7 - SOP 

8 - POP 

9 - Invoicing 

10 - Cash Book 

11 - BOM - (n/a) 

12 - Fixed Assets (n/a) 

98 - Ledger tax 

99 - Ledger unknown source 

Other Values between 16 

and 90 can be used to 

indicate transactions 

originating from an external 

program. 

PostedDate dd/mm/yyyy Yes Defaults to Import Date if left 

blank. 

TransactionAnalysisCode Text, Max 20 

characters 

No Must be a valid Sage 200 

Transactional Analysis Code 

 

As standard Transactions can be imported for Nominal Accounts that do not exist.  The 

postings will be made to the suspense account instead.  There is an option allowing this to 

be disabled.  If this is done all lines must have a valid Nominal Code. 

 

5.1.4. Cash Book Nominal Import 

 

Cash book nominal transaction files should be created using the following field listing as 

guidance: 

 

Field Name Format Required Import Rules 

CBTranType  Yes 0 – nominal taxable payment 

 1 – nominaltaxable receipt 

 2 – nominal non-

taxablepayment 

 3 – nominal non-taxable 

receipt 

CBAccountNumber Text, max 8 

characters 

Yes Bank Account must exist in 

200. 

TransactionReference Text, max 20 

characters 

No  
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Field Name Format Required Import Rules 

SecondReference Text, max 20 

characters 

No  

ChequeValue decimal Yes  

ChequeCurrency Text, max 3 

characters 

No Defaults to Bank currency if 

left blank. Only used for non-

base currency bank. 

ChequeToBaseCurrencyExchangeRate decimal No Uses Sage default if left 

blank. Only used for non-

base currency bank. 

ChequeToAccountCurrencyExchangeRate decimal No Uses Sage default if left 

blank. Only used for non-

base currency bank. 

GoodsValue decimal No If used, TaxValue + 

GoodsValue must equal 

ChequeValue. 

TaxCode int No TaxCode must exist in Sage 

200.  Uses Sage default if 

left blank 

TaxValue decimal No If used, TaxValue + 

GoodsValue must equal 

ChequeValue. 

ChequeDescription Text, max 60 

characters 

No  

PostedDate DD/MM/YYYY No Defaults to import date if left 

blank 

NominalAccountNumber Text, max 8 

characters 

Yes The complete nominal code 

must exist in 200. 

The 3 Columns 

NominalAccountNumber, 

NominalAccountCost Centre 

and 

NominalAccountDepartment 

must exist however cost centre 

and 

department can be blank if they 

are notused as part of the 

nominal code. 

NominalAccountCostCentre Text, max 3 

characters 

Yes  

NominalAccountDepartment Text, max 3 Yes  
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Field Name Format Required Import Rules 

characters 

NominalAccountNarrative Text, max 60 

characters 

No Defaults to 

ChequeDescription if blank 

NominalAccountTransactionAnalysisCode Text, max 20 

characters 

No  

 

5.1.5. Cash Book Sales and Purchase Import 

 

Cash Book Sales and Purchase transaction files should be created using the following field 

listing as guidance: 

 

Field Name Format Required Import Rules 

CBTranType integer Yes 0 – Sales Receipt 

1 – Sales Payment 

2 – Purchase Receipt 

3 – Purchase Payment 

CBAccountNumber Text, max 8 

characters 

Yes Bank Account must exist in 

200. 

GroupTransaction Y / N Yes if Group 

Transaction 

If not used transaction will be 

imported as ungrouped. 

GroupDate DD/MM/YYYY No Defaults to today if left blank. 

GroupReference Text, max 20 

characters 

No  

GroupDescription Text, max 20 

characters 

No  

GroupExchangeRate decimal No Only used for non-base 

currency bank accounts.  Uses 

Sage default if left blank. 

TraderACRef Text, max 8 

characters 

Yes For type 0/1 must be a valid 

customer account.  For type 2/3 

must be a valid supplier 

account.  For Group 

Transactions trader currency 

must match bank currency.. 

TransactionDate DD/MM/YYYY No Defaults to today if left blank or 

defaults to Group Date if using 

grouped transactions. 

TransactionReference Text, max 20 

characters 

No Defaults to Group Reference if 

using grouped transactions. 
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Field Name Format Required Import Rules 

SecondReference Text, max 20 

characters 

No  

ChequeValue decimal Yes  

SettlementDiscount decimal No  

ChequeCurrency Text, max 3 

characters 

No Defaults to trader currency if left 

blank.  Must be a valid currency 

code.  Not used for group 

transactions. 

TraderChequeValue decimal Yes if Trader 

currency 

different to 

cheque 

currency 

Not used for group 

transactions. 

BankToBaseCurrencyRate decimal No Uses Sage default if left blank.  

Not used for group 

transactions. 

ChequeToAccountCurrencyRate decimal No Uses Sage default if left blank. 

BankCharges decimal No Only used for non-base 

currency accounts. 

 

• CBTranType, CBAccountNumber, GroupTransaction, GroupDate, GroupReference, 

GroupDescription and GroupExchangeRate are header fields (shown in bold on the 

table above).  Where these are identical for multiple consecutive lines in the import 

file and GroupTransaction is set to “Y”, the import routine treats the lines as being 

part of a Grouped Transaction. 

 

5.1.6. Sales Ledger Account Import 

 

Sales Ledger Account import CSV files should be created using the following field listing as 

guidance: 

 

Field Name Format Required Import Rules 
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Field Name Format Required Import Rules 

AccountNumber Text, Max 8 

characters 

Yes1 If this matches an 

existing Customer 

Account number and 

the Update setting is 

enabled then the 

Customer in Sage 200 

will be updated. 

AccountName Text, Max 60 

characters 

Yes  

ShortName Text, Max 8 

characters 

No See Note 3 

AccountBalance Decimal No  

CreditLimit Decimal No  

CurrencyISOCode Text max 3 

characters 

No Must be a valid Sage 

200 Currency Code 

SYSExchangeRateType Integer No 0 – Single 

1 – Period 

2 – Single & Period 

CountryCode Text, Max 2 

characters 

No Must be a valid Sage 

200 Country Code 

TaxCode Integer No Must be a valid Sage 

200 Tax Code 

PriceBand Text, Max 30 

Characters 

No Must be a valid Sage 

200 Price Band 

TaxRegistrationNumber Text, Max 13 

characters 

No See Note 3 

MonthsToKeepTransactionsFor Integer No Must be between 0 and 

36 

DefaultOrderPriority Text, Max 1 

character 

No A – Z. See Note 3 

FinancialCharge Integer No Must be a valid Sage 

200 Finance Charge. 

See Note 3 

DefaultNominalAccountNumber Text, Max 8 

characters 

No Must be a valid Sage 

200 Nominal Account 

Number 

DefaultNominalCostCentre Text, Max 3 

characters 

No Must be a valid Sage 

200 Cost Centre 

DefaultNominalDepartment Text, Max 3 

characters 

No Must be a valid Sage 

200 Department 
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Field Name Format Required Import Rules 

SYSAccountType Integer No 0 – Balance Forward 

1 – Open Item 

2 – Auto Allocation 

EarlySettlementDiscountPercent Decimal No 0 – 100 

PaymentTermsInDays Integer No 0 – 255 

SYSPaymentTermsBasis Integer No 0 – Calendar Monthly 

1 – From Start of Month 

2 – From End of Month 

3 – From Document 

Date 

UseConsolidatedBilling True/False No  

InvoiceLineDiscountPercent Decimal No 0 – 100 

InvoiceDiscountPercent Decimal No 0 – 100 

SendCopyStatementToBranch True/False No  

AccountIsOnHold True/False No  

ValueOfCurrentOrdersInSOP Decimal No  

UseTransactionEmail True/False No  

TransactionEmail Text, Max 200 

characters 

No See Note 3 

MainTelephoneCountryCode Text, Max 5 

characters 

No See Note 3 

MainTelephoneAreaCode Text, Max 20 

characters 

No See Note 3 

MainTelephoneSubscriberNumber Text, Max 200 

characters 

No See Note 3 

MainFaxCountryCode Text, Max 5 

characters 

No See Note 3 

MainFaxAreaCode Text, Max 20 

characters 

No See Note 3 

MainFaxSubscriberNumber Text, Max 200 

characters 

No See Note 3 

AddressLine1 Text, Max 60 

characters 

No See Note 3 

AddressLine2 Text, Max 60 

characters 

No See Note 3 

AddressLine3 Text, Max 60 

characters 

No See Note 3 

AddressLine4 Text, Max 60 

characters 

No See Note 3 
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Field Name Format Required Import Rules 

City Text, Max 60 

characters 

No See Note 3 

County Text, Max 60 

characters 

No See Note 3 

Country Text, Max 60 

characters 

No See Note 3 

PostCode Text, Max 10 

characters 

No See Note 3 

MainWebsite Text, Max 200 

characters 

No See Note 3 

ContactSalutation Text, Max 50 

characters 

No Must be a valid Sage 

200 Salutation. See 

Note 3 

ContactFirstName Text, Max 60 

characters 

No See Note 3 

ContactMiddleName Text, Max 60 

characters 

No See Note 3 

ContactLastName Text, Max 60 

characters 

No See Note 3 

ContactTelephoneCountryCode Text, Max 5 

characters 

No See Note 3 

ContactTelephoneAreaCode Text, Max 20 

characters 

No See Note 3 

ContactTelephoneSubscriberNumber Text, Max 200 

characters 

No See Note 3 

ContactFaxCountryCode Text, Max 5 

characters 

No See Note 3 

ContactFaxAreaCode Text, Max 20 

characters 

No See Note 3 

ContactFaxSubscriberNumber Text, Max 200 

characters 

No See Note 3 

ContactMobileCountryCode Text, Max 5 

characters 

No See Note 3 

ContactMobileAreaCode Text, Max 20 

characters 

No See Note 3 

ContactMobileSubscriberNumber Text, Max 200 

characters 

No See Note 3 

ContactEmailAddress Text, Max 227 

characters 

No See Note 3 

DateFinanceChargeLastRun dd/mm/yyyy No See Note 3 
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Field Name Format Required Import Rules 

AssociatedOfficeType Integer No 0 – Independent 

1 – Branch 

2 – Head Office 

3 – Independent No 

Statement 

4 – Head Office No 

Statement 

AssociatedHeadOfficeAccountNum Text, Max 8 

characters 

No Must be a valid Sage 

200 Customer Account 

TradingTerms Text, Max 30 

characters 

No See Note 3 

CreditReference Text, Max 60 

characters 

No See Note 3 

CreditBureau Text, Max 50 

characters 

No Must be a valid Sage 

200 Credit Bureau. See 

Note 3 

CreditPosition Text, Max 50 

characters 

No Must be a valid Sage 

200 Credit Position. 

See Note 3 

TermsAgreed True/False No  

AccountOpened dd/mm/yyyy No See Note 3 

LastCreditReview dd/mm/yyyy No See Note 3 

NextCreditReview dd/mm/yyyy No See Note 3 

ApplicationDate dd/mm/yyyy No See Note 3 

DateReceived dd/mm/yyyy No See Note 3 

SpareText1 Text, max 100 chars No  

SpareText2 Text, max 100 chars No   

SpareText3 Text, max 100 chars No  

SpareNumber1 Decimal No  

SpareNumber2 Decimal No  

SpareNumber3 Decimal No  

SpareDate1 Date, dd/mm/yyyy No  

SpareDate2 Date, dd/mm/yyyy No  

SpareDate3 Date, dd/mm/yyyy No  

SpareBit1 True/False No  

SpareBit2 True/False No  

SpareBit3   True/False No  
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Field Name Format Required Import Rules 

AnalysisName\1 Text, Max 60 

characters 

No Must be a valid Sage 

200 Analysis Code 

name. See Note 2 

AnalysisName\2 Text, Max 60 

characters 

No Must be a valid Sage 

200 Analysis Code 

name. See Note 2 

AnalysisValue\1 Text, Max 60 

characters 

No Must be a valid value 

for the specified 

analysis Code. See 

Note 2 

AnalysisValue\2 Text, Max 60 

characters 

No Must be a valid value 

for the specified 

analysis Code. See 

Note 2 

 
1. This field can be left blank if the Auto Customer Number feature is enabled. This can 

be enabled by going to Edit > Plugin settings > Import settings > Sales Account 
Import > Auto Customer Number tab: 
 

 
 

To enable the Auto Customer number feature, you check the enabled checkbox. This 
automatically creates a unique customer account reference from the AccountName 
field. The name generator can be configured to take a certain number of characters 
from the name, a separator character and a number of digits.  

 
2. Up to 20 Analysis Codes can be specified by adding columns with increasing 

numbers. i.e. 

AnalysisName\2,AnalysisValue\2.....AnalysisName\20,AnalysisValue\20 

 

3. When updating existing customers, if the value in the column is set to the value setup 
in the Import Settings for Blank field value then the field will be updated with a blank 
value. 
 

4. Default settings can also be configured from the plugin settings tab: 
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• The Data Exchange can be configured to update existing accounts by checking 
Update Existing Customers. 
 

• The default nominal code, payment terms, keep transaction settings and country 
code can also be configured for new accounts.  

 

5.1.7. Sales Ledger Account E-Mail Address Import 

 

Sales Ledger E-Mail address import CSV files should be created using the following field 

listing as guidance: 

 

Field Name Format Required Import Rules 

AccountRef Text, max 8 chars Yes This is the unique Customer account 

reference number 

EmailAddress Text, max 227 

chars 

Yes   

 

• No validation is performed on the e-mail address to check that it is a valid e-mail 

address.  It will be imported as is. 

• The e-mail address will be imported as the main contact e-mail address for that 

customer overwriting any previous e-mail address. 

 

5.1.8. Sales Ledger Account Bank Details Import 

 

Field Name Format Required Import Rules 

AccountRef Text, max 8 

characters 

Yes Must match an existing Sage 200 

Customer account. 

SortCode Text, max 8 

characters 

Yes Must only contain digits 
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Field Name Format Required Import Rules 

AccountNumber Text, max 20 

characters 

Yes  

AccountName Text, max 60 

characters 

Yes  

BankPaymentRef Text, max 60 

characters 

  

IBANNumber Text, max 40 

characters 

  

BICNumber Text, max 11 

characters 

  

RollNumber Text, max 30 

characters 

  

BACSReference Text, max 60 

characters 

  

AdditionalReference Text, max 255 

characters 

  

NonUKSortCode Text, max 20 

characters 

  

 

Note: if there are multiple lines for the same customer AccountRef, only the last one will be 

applied. 

 

5.1.9. Sales Order Import 

 

Sales order CSV files should be created using the following field listing as guidance: 

 

Field Name Format Required Import Rules 

OrderType 1 or 2 Yes 1 – Sales Order 

2 – Sales Return 

3 – Quotation 

4 – Quotation for Prospect 

OrderNumber Text, max 30 

characters. 

No1 Must not already exist in Sage 200.  

Ignored if order number is set to 

automatically generate. 

CashAccount Yes/No   

CustAccRef Text, max 8 

characters. 

Yes if Cash 

Account is 

No 

Must be a valid Customer Ref in 

Sage 200 

OrderWarehouse Text, max 20 

characters 

No Must be a valid Warehouse 
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Field Name Format Required Import Rules 

OrderDate dd/mm/yyyy No Defaults to import date if left blank 

OrderRequestedDate dd/mm/yyyy No Defaults to OrderDate if left blank 

OrderPromisedDate dd/mm/yyyy No Defaults to OrderDate if left blank 

CustomerOrderNumber Text, max 30 

characters. 

No  

OrderDiscountPercentage Decimal No Must be between 0 and 100 

DelPostalName Text, max 60 

characters. 

No  

DelAddressLine1 Text, max 60 

characters. 

No  

DelAddressLine2 Text, max 60 

characters. 

No  

DelAddressLine3 Text, max 60 

characters. 

No  

DelAddressLine4 Text, max 60 

characters. 

No  

DelPostCode Text, max 10 

characters. 

No  

DelCity Text, max 60 

characters. 

No  

DelCounty Text, max 60 

characters. 

No  

DelContact Text, max 50 

characters. 

No  

DelTelephone Text, max 30 

characters. 

No  

DelFax Text, max 30 

characters. 

No  

DelEmail 

 

Text, max 255 

characters. 

No  

DelTaxNumber Text, max 30 

characters. 

No  

DelTaxCode Integer No Must be a valid Sage 200 Tax Code. 

DelCountryCode Text, max 2 

characters. 

No Must be a valid Sage 200 Country 

Code 

DelCountry Text, max 60 

characters 

No  

InvPostalName Text, max 60 

characters. 

No Only used on Cash Account Orders 
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Field Name Format Required Import Rules 

InvAddressLine1 Text, max 60 

characters. 

No Only used on Cash Account Orders 

InvAddressLine2 Text, max 60 

characters. 

No Only used on Cash Account Orders 

InvAddressLine3 Text, max 60 

characters. 

No Only used on Cash Account Orders 

InvAddressLine4 Text, max 60 

characters. 

No Only used on Cash Account Orders 

InvPostCode Text, max 10 

characters. 

No Only used on Cash Account Orders 

InvCity Text, max 60 

characters. 

No Only used on Cash Account Orders 

InvCounty  No Only used on Cash Account Orders 

InvCountry Text, max 60 

characters 

No Only used on Cash Account Orders. 

PaymentInFull Yes / No No Leave blank if no payment is taken. 

PaymentValue Decimal Yes if 

“PaymentInF

ull” is No 

Must be less than the order total 

value. 

PaymentRef Text, max 20 

characters. 

No  

PaymentMethod Text, max 20 

characters. 

Yes if a 

payment is 

taken, 

Must be a valid Sage 200 SOP 

payment method 

AnalysisCodeName1 Text, max 60 

characters. 

Yes if 

“AnalysisCod

eValue1” or 

LineAnalysis

Value1 is 

specified.   

Must be a valid SOP Analysis Code 

name in Sage 200.  See Note 2 

AnalysisCodeValue1 Text, max 60 

characters. 

No Must be a valid value for the 

specified analysis code.  See Note 2 

AnalysisCodeName2 Text, max 60 

characters. 

Yes if 

“AnalysisCod

eValue2” or 

“LineAnalysis

Value2” is 

specified.  

Must be a valid SOP Analysis Code 

name in Sage 200.  See Note 2 

AnalysisCodeValue2 Text, max 60 

characters. 

No  Must be a valid value for the 

specified analysis code.  See Note 2 
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Field Name Format Required Import Rules 

OrderSpareText1 Text, max 100 

characters. 

No  

OrderSpareText2 Text, max 100 

characters. 

No  

OrderSpareText3 Text, max 100 

characters. 

No  

OrderSpareNumber1 decimal No  

OrderSpareNumber2 decimal No  

OrderSpareNumber3 decimal No  

OrderSpareDate1 dd/mm/yyyy No  

OrderSpareDate2 dd/mm/yyyy No  

OrderSpareDate3 dd/mm/yyyy No  

OrderSpareBit1 Yes / No No  

OrderSpareBit2 Yes / No No  

OrderSpareBit3 Yes / No No  

OrderProcessing Text, max 4 

characters 

No On Sales Orders valid characters are 

A,D,I and P. These will process the 

order to the following stages: 

A – Allocate 

D – Despatch 

I – Invoice 

P – Post Invoice 

 

On Sales Returns valid characters 

are R, C and P. These will process 

the return to the following Stages: 

R – Receive 

C – Credit 

P – Post Credit 

OrderPriority Text, max 1 

character 

unless “blank” 

No Must be between A and Z. 

 

If it’s to be blank then use the word 

“blank” 

 

If left blank will use the customers 

default from Sage 200. 

ArePricesTaxInclusive Yes / No No  

Exchange Rate Decimal No Only for Foreign Currency 

Orders/Returns 
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Field Name Format Required Import Rules 

LineType Integer Yes 1 – Stock item 

2 – Free Text item 

3 – Additional Charge item 

4 – Comment Line 

5 – SOP Item code 

ProductCode Text, max 30 

characters. 

Yes If LineType = 1 then must be a valid 

stock item code. 

If LineType = 3 then must be a valid 

additional charge code. 

If LineType = 5 then must be a valid 

SOP item code. 

Ignored for LineType 2 or 4. 

ProductDescription Text, See Note 

4 

Yes.  If LineType = 2 or 4 it must not be 

blank. 

If LineType = 1 or 5 and not blank 

then used  to populate the item 

description. 

If LineType = 3 and not blank then 

used to override the additional 

charge name.  

FulfilmentMethod Integer No Only for Line Type 1, if left blank it 

will default to Stock. 

1 – Stock 

2 – Supplier via Stock 

3 – Direct to Customer 

Warehouse Text, max 20 

characters 

No5 If LineType = 1 and multi 

warehousing is enabled a 

warehouse. Defaults to 

OrderWarehouse (if specified) if left 

blank. 

Ignored for all other LineTypes. 

Quantity Decimal Yes Line type1,2 and 5 only. Must be 

greater than zero 

UnitPrice Decimal Yes Required for LineType = 2. Ignored 

for LineType = 4 

TaxCode Integer No Must be a valid Sage 200 Tax Code. 

Ignored for LineType = 4 

TaxAmount Decimal No Ignored for LineType = 4 

DiscountPercent Decimal No Line Type 1, 2 and 5 only. Must be 

between 0 and 100. 
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Field Name Format Required Import Rules 

DiscountValue Decimal No Line Type 1, 2 and 5 only. Must not 

exceed Unit Price. This value will be 

used and override DiscountPercent if 

a value is entered for both. 

NominalCode  No Used to override the default nominal 

code. Nominal, CC and Dept must be 

a valid Sage 200 Nominal. Ignored 

for LineType = 4 

CostCentre  No Used to override the default cost 

centre. To override this with a blank 

Cost Centre use the keyword “blank” 

in the file. Ignored for LineType = 4 

Department  No Used to override the default 

department. To override this with a 

blank Department use the keyword 

“blank” in the file. Ignored for 

LineType = 4 

ShowOnPickingList Yes / No No LineType = 4 only 

ShowOnCustomerDocs Yes / No No LineType = 4 only 

CostPrice  No Ignored for LineType = 4 

LineRequestedDate dd/mm/yyyy No LineType 1,2 and 5 only 

LinePromisedDate dd/mm/yyyy No LineType 1,2 and 5 only 

LineAnalysisCode1 Text, max 60 

characters. 

No AnalysisCodeName1 must be 

specified.  Must be a valid value for 

the specified analysis code.  Defaults 

to AnalysisCodeValue1 if left blank.  

See Note 3 

LineAnalysisCode2 Text, max 60 

characters. 

No AnalysisCodeName2 must be 

specified.  Must be a valid value for 

the specified analysis code.  Defaults 

to AnalysisCodeValue1 if left blank.  

See Note 3 

LineSpareText1 Text, max 100 

characters. 

No  

LineSpareText2 Text, max 100 

characters. 

No  

LineSpareText3 Text, max 100 

characters. 

No  

LineSpareNumber1 decimal No  

LineSpareNumber2 decimal No  
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Field Name Format Required Import Rules 

LineSpareNumber3 decimal No  

LineSpareDate1 dd/mm/yyyy No  

LineSpareDate2 dd/mm/yyyy No  

LineSpareDate3 dd/mm/yyyy No  

LineSpareBit1 Yes / No No  

LineSpareBit2 Yes / No No  

LineSpareBit3 Yes / No No  

ProjectCode Text, max 30 

characters 

No Only used for LineType =2. Must be 

a valid Project Code for the specified 

Customer. 

ProjectItem Text, max 30 

characters 

Yes if Project 

Code 

specified 

Only used for LineType =2. Must be 

a valid Project Item on the specified 

Project. 

ProspectPostalName Text, max 60 

characters 

Yes, if 

Quotation for 

Prospect 

order 

Only used for OrderType =4 

ProspectAddressLine1 Text, max 60 

characters 

No Only used for OrderType =4 

ProspectAddressLine2 Text, max 60 

characters 

No Only used for OrderType =4 

ProspectAddressLine3 Text, max 60 

characters 

No Only used for OrderType =4 

ProspectAddressLine4 Text, max 60 

characters 

No Only used for OrderType =4 

ProspectCity Text, max 60 

characters 

No Only used for OrderType =4 

ProspectCounty Text, max 60 

characters 

No Only used for OrderType =4 

ProspectPostCode Text, max 10 

characters 

No Only used for OrderType =4 

PaymentDate dd/mm/yyyy No  

 

The fields shown in bold in the table above are header fields.  Where these are identical for 

multiple consecutive lines in the import file the import routine treats the lines as being part of 

the same order/return. 

 

1. If “Automatically generate order and return numbers” is disabled in SOP Settings an 

OrderNumber must be specified. 
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2. Up to 20 Analysis codes can be specified by adding additional columns with 

increasing numbers. i.e. AnalysisCodeName2, AnalysisCodeValue2 ....  

AnalysisCodeName20, AnalysisCodeValue20 

 

3. Up to 20 Line Analysis codes can be specified by adding additional columns with 

increasing numbers.  For each Line analysis code the matching AnalysisCodeName 

must be specified. 

 

4. If you need a multi-line product description you should use the xml file format.  CSV 

does not easily handle multi-line fields. 

 

5. If Display multiple locations” is enabled in Stock Control Settings then 

OrderWarehouse and/or Warehouse must be specified 

 

 

5.1.10. Purchase Ledger Account Import 

 

Purchase Ledger Account import CSV files should be created using the following field listing 

as guidance: 

  

Field Name Format Required Import Rules 

AccountNumber Text, Max 8 

characters 

Yes If this matches an existing 

Supplier Account number and the 

Update setting is enabled then the 

Supplier in Sage 200 will be 

updated. 

AccountName Text, Max 60 

characters 

Yes  

ShortName Text, Max 8 

characters 

No  

CreditLimit Decimal No  

CurrencyISOCode Text max 3 

characters 

No Must be a valid Sage 200 

Currency Code 

SYSExchangeRateType Integer No 0 – Single 

1 – Period 

2 – Single & Period 

CountryCode Text, Max 2 

characters 

No Must be a valid Sage 200 Country 

Code 

TaxCode Integer No Must be a valid Sage 200 Tax 

Code 

TaxRegistrationNumber Text, Max 13 No  



P a g e  | 41 

  

 

characters 

MonthsToKeepTransactionsFor Integer No Must be between 0 and 36 

DefaultOrderPriority Text, Max 1 

character 

No A – Z 

DefaultNominalAccountNumber  No Must be a valid Sage 200 

Nominal Account Number 

DefaultNominalCostCentre Text, Max 3 

characters 

No Must be a valid Sage 200 Cost 

Centre 

DefaultNominalDepartment Text, Max 3 

characters 

No Must be a valid Sage 200 

Department 

SYSAccountType Text, Max 8 

characters 

Integer 

 

No 0 – Balance Forward 

1 – Open Item 

2 – Auto Allocation 

PLPaymentGroup Integer No 0 – 10 

EarlySettlementDiscountPercent Decimal No 0 – 100 

DaysEarlySettlementDiscountAppl

ies 

Integer No  

PaymentTermsInDays Integer No 0 – 255 

SYSPaymentTermsBasis Integer No 0 – Calendar Monthly 

1 – From Start of Month 

2 – From End of Month 

3 – From Document Date 

AccountIsOnHold True/False No  

ValueOfCurrentOrdersInPOP Decimal No  

UseTransactionEmail True/False No  

TransactionEmail Text, Max 200 

characters 

No  

MainTelephoneCountryCode Text, Max 5 

characters 

No  

MainTelephoneAreaCode Text, Max 20 

characters 

No  

MainTelephoneSubscriberNumber Text, Max 200 

characters 

No  

MainFaxCountryCode Text, Max 5 

characters 

No  

MainFaxAreaCode Text, Max 20 

characters 

No  

MainFaxSubscriberNumber Text, Max 200 

characters 

No  

AddressLine1 Text, Max 60 No  
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characters 

AddressLine2 Text, Max 60 

characters 

No  

AddressLine3 Text, Max 60 

characters 

No  

AddressLine4 Text, Max 60 

characters 

No  

City Text, Max 60 

characters 

No  

County Text, Max 60 

characters 

No  

Country Text, Max 60 

characters 

No  

PostCode Text, Max 10 

characters 

No  

MainWebsite Text, Max 200 

characters 

No  

ContactSalutation Text, Max 50 

characters 

No Must be a valid Sage 200 

Salutation 

ContactFirstName Text, Max 60 

characters 

No  

ContactMiddleName Text, Max 60 

characters 

No  

ContactLastName Text, Max 60 

characters 

No  

ContactTelephoneCountryCode Text, Max 5 

characters 

No  

ContactTelephoneAreaCode Text, Max 20 

characters 

No  

ContactTelephoneSubscriberNum

ber 

Text, Max 200 

characters 

No  

ContactFaxCountryCode Text, Max 5 

characters 

No  

ContactFaxAreaCode Text, Max 20 

characters 

No  

ContactFaxSubscriberNumber Text, Max 200 

characters 

No  

ContactMobileCountryCode Text, Max 5 

characters 

No  

ContactMobileAreaCode Text, Max 20 

characters 

No  
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ContactMobileSubscriberNumber Text, Max 200 

characters 

No  

TradingTerms Text, Max 30 

characters 

No  

CreditReference Text, Max 60 

characters 

No  

CreditBureau Text, Max 50 

characters 

No Must be a valid Sage 200 Credit 

Bureau 

CreditPosition Text, Max 50 

characters 

No Must be a valid Sage 200 Credit 

Position 

TermsAgreed True/False No  

AccountOpened dd/mm/yyyy No  

LastCreditReview dd/mm/yyyy No  

NextCreditReview dd/mm/yyyy No  

ApplicationDate dd/mm/yyyy No  

DateReceived dd/mm/yyyy No  

AnalysisName\1 Text, Max 60 

characters 

No Must be a valid Sage 200 

Analysis Code name. See Note 1 

AnalysisName\2 Text, Max 60 

characters 

No Must be a valid Sage 200 

Analysis Code name. See Note 1 

AnalysisValue\1 Text, Max 60 

characters 

No Must be a valid value for the 

specified analysis Code. See 

Note 1 

AnalysisValue\2 Text, Max 60 

characters 

No Must be a valid value for the 

specified analysis Code. See 

Note 1 

 
1. Up to 20 Analysis Codes can be specified by adding columns with increasing 

numbers. i.e. 

AnalysisName\2,AnalysisValue\2.....AnalysisName\20,AnalysisValue\20 

 

2. When updating existing supplier, if a column is left blank the value will not be 
changed. 
 

• Default supplier settings can be configured from the import plugin settings: 
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• The Data Exchange can be configured to update existing accounts by checking 
Update Existing Suppliers. 
 

• The default nominal code, payment terms, keep transaction settings and country 
code can also be configured for new accounts.  

 

5.1.11. Purchase Order Import 

 

Purchase order CSV files should be created using the following field listing as guidance: 

 

Field Name Format Required Import Rules 

OrderType Integer Yes 1 – Purchase Order 

2 – Purchase Return 

OrderNumber Text, max 30 

characters 

No1 Must not already exist. 

SuppAccRef Text, max 8 

characters 

Yes Must be a valid Supplier account 

OrderDate DD/MM/YYYY No Defaults to today if left blank. 

OrderRequestedDate DD/MM/YYYY No  

SupplierDocumentNumber Text, max 30 

characters 

No  

OrderWarehouse Text, max 20 

characters 

No Must be a valid Warehouse. 

ExchangeRate Decimal No  

LineType Integer Yes 1 – Standard Item Line 

2 – Free Text Line 

3 – Additional Charge Line 

4 – Comment Line 
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Field Name Format Required Import Rules 

ProductCode DD/MM/YYYY Yes If LineType = 1 then must be valid 

stock item code 

If LineType = 3 then must be valid 

additional charge code 

If LineType = 2 or 4 should be left 

blank 

ProductDescription Text, max 5000 

characters 

Yes If LineType = 2 or 4 it must not be 

blank. 

If LineType = 1 and not blank then 

used to populate the item line 

description 

If LineType = 3 and not blank then 

used to override the additional 

charge name 

Warehouse Text, max 20 

characters 

No2 If LineType =1 and multiple 

warehousing is 

switched on a warehouse must be 

specified. 

Defaults to OrderWarehouse (if 

specified) if left blank. 

Quantity Decimal Yes Line quantity, must be greater 

than 0 

UnitPrice Decimal Yes If not blank it overrides the default 

unit cost. 

Required for LineType=2. 

TaxCode Text, max 3 

characters 

No Uses Sage default if left blank. 

TaxAmount Decimal Np  

DiscountPercent Decimal No  

DiscountValue Decimal No If specified DiscountPercent will 

be calculated based on this. 

NominalCode 3 Text, max 8 

characters 

No Used to override the default 

nominal code. 

CostCentre 3 Text, max 3 

characters 

No Used to override the default cost 

centre. To override this with a 

blank Cost Centre use the 

keyword “blank” in the csv or XML 

file. 
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Field Name Format Required Import Rules 

Department 3 Text, max 3 

characters 

No Used to override the default 

department. To override this with 

a blank Department use the 

keyword “blank” in the csv or XML 

file. 

ShowOnSuppDocs Y/N No  

ProjectCode Text, max 30 

characters 

No4 Only used for LineType =1 or 2. 

Must be a valid Project Code. 

ProjectItem Text, max 30 

characters 

No4 Only used for LineType =1 or 2. 

Must be a valid Project Item on 

the specified Project. 

LineRequestedDate DD/MM/YYYY No Defaults to OrderRequestedDate 

if left blank. 

AnalysisCodeName1 Text, max 60 

characters 

Yes if 

“AnalysisC

odeValue1

” or 

“LineAnaly

sisValue”1 

is 

specified 

Must be a valid POP Analysis 

Code Name in Sage 200. See 

Note 5. 

AnalysisCodeValue1 Text, max 60 

characters 

No Must be a valid value for the 

specified analysis code. See Note 

5. 

AnalysisCodeName2 Text, max 60 

characters 

Yes if 

“AnalysisC

odeValue2

” or 

“LineAnaly

sisValue2” 

is 

specified 

Must be a valid POP Analysis 

Code Name in Sage 200. See 

Note 5. 

AnalysisCodeValue2 Text, max 60 

characters 

No Must be a valid value for the 

specified analysis code. See Note 

5. 

LineAnalysisCode1 Text, max 60 

characters 

No AnalysisCodeName1 must be 

specified. Must be a valid value 

for the specified analysis code. 

Defaults to AnalysisCodeValue1 if 

left blank. See Note 6. 
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Field Name Format Required Import Rules 

LineAnalysisCode2 Text, max 60 

characters 

No AnalysisCodeValue2 must be 

specified. Must be a valid value 

for the specified analysis code. 

Defaults to AnalysisCodeValue2 if 

left blank. See Note 6. 

OrderOriginator Text, max 60 

characters 

No It must be valid Sage user. 

OrderTakenBy Text, max 60 

characters 

No It must be a valid Sage user. 

 

• OrderType, OrderNumber, SuppAccRef, OrderDate, OrderRequestedDate, 

SupplierDocumentNumber and OrderWarehouse are header fields (shown in bold on 

the table above).  Where these are identical for multiple consecutive lines in the 

import file the import routine treats the lines as being part of the same order/return. 

 

1. If “Automatically generate order and return numbers” is disabled in POP Settings then 

anOrderNumber must be specified. 

 

2. If “Display multiple locations” is enabled in Stock Control Settings then 

OrderWarehouse and/or Warehouse must be specified. 

 

3. If “Allow amendment of Nominal Codes” is disabled in POP Settings then the 

NominalCode, CostCenter and Department columns will be ignored. 

 

4. If a ProjectCode is specified, a ProjectItem must also be specified. 

 

5. Up to 20 Analysis codes can be specified by adding additional columns with 
increasing numbers i.e: 
AnalysisCodeName2, AnalysisCodeValue2…AnalysisCodeName20,                        
AnalysisCodeValue20 

 
6. Up to 20 Line Analysis codes can be specified by adding additional columns with 

increasing numbers. For each Line analysis code the matching AnalysisCodeName 
must be specified.  

 

 

5.1.12. Supplier Bank Details Import 

 

Supplier Bank Details CSV files should be created using the following field listing as 

guidance: 

 

Field Name Format Required Import Rules 
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Field Name Format Required Import Rules 

SupplierCode Text, Max 8 Chars Yes Must be a valid supplier account reference 

SortCode Text, Max 10 Chars Yes Must contain only integers 

AccountNumber Text, Max 20 Chars Yes Must contain only integers 

AccountName Text, Max 60 Chars Yes  

BankPaymentRef Text, Max 60 Chars Yes  

PaymentGroup Integer No Must be in a range 0-9 

IBANNumber Text, max 40 chars No  

BICNumber Text, max 11 chars No  

RollNumber Text, max 30 chars No  

BACSReference Text, max 60 chars No  

AdditionalReference Text, max 255 chars No  

NonUKSortCode Text, max 20 chars No  

 

5.1.13. Intrastat Item Import 

 

Intrastat Item CSV files should be created using the following field listing as guidance: 

 

Field Name Format Required Import Rules 

Destination Type A or D Yes  

Order/ReturnNo Text, Max 20 Chars No 1  

Account Ref Text, Max 8 Chars No 1  

Stock Code Text, Max 30 Chars No 1  

Commodity Code Text, Max 8 Chars No 2 If a valid stock code is entered this will 

default to the Stock Items Commodity 

Code if left blank. 

Goods Value Integer, Max 12 

digits 

Yes Must be greater than zero 

Net Mass Integer, Max 7 digits No Defaults to 0 if not entered. 

Supplementary Units Integer, Max 10 

digits 

No Defaults to 0 if not entered. 

Reference No Text, Max 20 Chars No  

NOTC 2 Characters No Must be a valid Nature of Transaction 

Code in Sage 200.  Default from SOP 

Settings if left blank 

Destination Country 2 Characters Yes Must be a valid EU Country Code in 

Sage 200 



P a g e  | 49 

  

 

Field Name Format Required Import Rules 

Terms of Delivery 3 Characters No One of following values: EXW, FCA, 

FAS, FOB, CFR, CIF, CPT, CIP, DAF, 

DES, DEQ, DDU, DDP, XXX.  Default 

from SOP Settings if left blank 

Tax Month MM No Tax month intrastat is added to.  

Defaults to import date month if left 

blank. 

Tax Year YYYY No Tax year intrastat is added to.  Defaults 

to import date year if left blank. 

Entry Date DD/MM/YYYY No Defaults to the date import is run if left 

blank 

 

• One of “Order/ReturnNo”, “Account Ref” or “Stock Code” must be provided. 

 

• A Commodity code is required if Intrastat Consolidation is enabled (Accounting 

System Manager/System Settings) and the Goods Value is greater than the threshold 

set. 

 

5.1.14. Despatch Sales Order Import 

 

Despatch Sales Order CSV files should be created using the following field listing as 

guidance: 

 

Field Name Format Required Import Rules 

SalesOrderNumber Text, max 30 chars Yes Must be an existing Sales Order 

Number 

StockItemCode Text, Max 20 Chars Yes Must be a valid Stock Item Code 

Quantity Decimal Yes For multiple Batch/Serial Items 

this column should be populated 

with the Total quantity being 

despatched and the Batch Serial 

Quantity on each line populated 

with the corresponding quantity 

for this Batch/Serial number. 

Warehouse Max 20 alphanumeric 

characters 

Yes Must be a valid Warehouse  

BatchSerialNo Text, Max 30 chars No Must already exist for the stock 

item. 

BatchSerialQuantity Decimal No Must be 1 for Serial numbered 

Items 
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Field Name Format Required Import Rules 

BatchSerialAlternateRef Text, Max 30 chars No  

BatchSerialSellBy DD/MM/YYYY No  

BatchSerialUseBy DD/MM/YYYY No  

BatchAttributeTitle1 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle2 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle3 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle4 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle5 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle6 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle7 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle8 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle9 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle10 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle11 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle12 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle13 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle14 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle15 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle16 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle17 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle18 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle19 Text No  Must be a valid Batch Attribute for 
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Field Name Format Required Import Rules 

this Stock Item 

BatchAttributeTitle20 Text No  Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeValue1 Text, Max 60 Chars No  

BatchAttributeValue2 Text, Max 60 Chars No  

BatchAttributeValue3 Text, Max 60 Chars No  

BatchAttributeValue4 Text, Max 60 Chars No  

BatchAttributeValue5 Text, Max 60 Chars No  

BatchAttributeValue6 Text, Max 60 Chars No  

BatchAttributeValue7 Text, Max 60 Chars No  

BatchAttributeValue8 Text, Max 60 Chars No  

BatchAttributeValue9 Text, Max 60 Chars No  

BatchAttributeValue10 Text, Max 60 Chars No  

BatchAttributeValue11 Text, Max 60 Chars No  

BatchAttributeValue12 Text, Max 60 Chars No  

BatchAttributeValue13 Text, Max 60 Chars No  

BatchAttributeValue14 Text, Max 60 Chars No  

BatchAttributeValue15 Text, Max 60 Chars No  

BatchAttributeValue16 Text, Max 60 Chars No  

BatchAttributeValue17 Text, Max 60 Chars No  

BatchAttributeValue18 Text, Max 60 Chars No  

BatchAttributeValue19 Text, Max 60 Chars No  

BatchAttributeValue20 Text, Max 60 Chars No  

5.1.15. Receive Purchase Order Import 

 

Receive Purchase Order CSV files should be created using the following field listing as 

guidance: 

 

Field Name Format Required Import Rules 

PurchaseOrderNumber Text, max 30 chars Yes Must be an existing Purchase 

Order Number 

LineType Integer Yes 1 – Stock Item Line 

2 – Free Text Line 

StockItemCode Text, Max 20 Chars Yes If Line Type  = 1 Must be a valid 

Stock Item Code 

If Line Type = 2 Should be left 

blank 
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Field Name Format Required Import Rules 

Description Text No If Line Type = 1 Should be left 

blank 

If Line Type = 2 Must equal the 

free text description on the 

purchase order line 

TotalQuantity Decimal Yes  

Reference Text, Max 40 Chars Yes  

BatchSerialNo Text, Max 30 chars No Must be unique for items that do 

not allow duplicates 

BatchSerialQuantity Decimal No Must be 1 for Serial numbered 

Items 

BatchSerialAlternateRef Text, Max 30 chars No  

BatchSerialSellBy DD/MM/YYYY No  

BatchSerialUseBy DD/MM/YYYY No  

BatchAttributeTitle1 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle2 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle3 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle4 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle5 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle6 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle7 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle8 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle9 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle10 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle11 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle12 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle13 Text No Must be a valid Batch Attribute for 

this Stock Item 
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Field Name Format Required Import Rules 

BatchAttributeTitle14 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle15 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle16 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle17 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle18 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle19 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeTitle20 Text No Must be a valid Batch Attribute for 

this Stock Item 

BatchAttributeValue1 Text, Max 60 Chars No  

BatchAttributeValue2 Text, Max 60 Chars No  

BatchAttributeValue3 Text, Max 60 Chars No  

BatchAttributeValue4 Text, Max 60 Chars No  

BatchAttributeValue5 Text, Max 60 Chars No  

BatchAttributeValue6 Text, Max 60 Chars No  

BatchAttributeValue7 Text, Max 60 Chars No  

BatchAttributeValue8 Text, Max 60 Chars No  

BatchAttributeValue9 Text, Max 60 Chars No  

BatchAttributeValue10 Text, Max 60 Chars No  

BatchAttributeValue11 Text, Max 60 Chars No  

BatchAttributeValue12 Text, Max 60 Chars No  

BatchAttributeValue13 Text, Max 60 Chars No  

BatchAttributeValue14 Text, Max 60 Chars No  

BatchAttributeValue15 Text, Max 60 Chars No  

BatchAttributeValue16 Text, Max 60 Chars No  

BatchAttributeValue17 Text, Max 60 Chars No  

BatchAttributeValue18 Text, Max 60 Chars No  

BatchAttributeValue19 Text, Max 60 Chars No  

BatchAttributeValue20 Text, Max 60 Chars No  

 

• The fields shown above in bold are header fields. Where these are identical for 

multiple consecutive lines in the import file the import routine treats the lines as being 

part of the same batch/serial goods receipt. In this scenario the Total Quantity field 

must be the total of all of these items being received. 
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• The setting to Record Batch & Serial numbered items when goods are received must 

be enabled on the Stock item for the Batch or Serial number fields to be populated. 

 

5.1.16. Stock Item Import/Update 

 

Stock Item CSV files should be created using the following field listing as guidance: 

For existing items if a column is left blank the value will not be changed. 

 

Field Name Format Required Import Rules 

StockItemCode Text, max 30 

chars 

Yes If it matches an existing item 

the item will be updated. 

StockItemName Text, Max 60 

Chars 

Yes Must not be left blank for new 

StockItems. 

StockItemDescription Text No  

ProductGroup Text, Max 20 

Characters 

Yes Must not be left blank for new 

StockItems.  Must be a valid 

Sage 200 Product Group 

Code. 

TaxCode Integer Yes Must not be left blank for new 

StockItems.  Must be a valid 

Sage 200 Tax Code. 

ManufacturersName Text, Max 40 

Chars 

No  

ManufacturersPartNumber Text, Max 40 

Chars 

No  

CommodityCode Text, Max 8 

Chars 

No  

NetMass Decimal No  

StockTakeDays Integer No  

AssetOfStock – 

AccountNumber 

Text, max 8 

Characters 

No Must be a valid Sage 200 

Nominal Account Number. 

AssetOfStock – CostCentre Text, max 3 

Characters 

Yes if 

AssetOfStock – 

AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Cost Centre. 

AssetOfStock – Department Text, max 3 

Characters 

Yes if 

AssetOfStock – 

AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Department. 

Revenue – AccountNumber Text, max 8 

Characters 

No Must be a valid Sage 200 

Nominal Account Number. 



P a g e  | 55 

  

 

Field Name Format Required Import Rules 

Revenue – CostCentre Text, max 3 

Characters 

Yes if Revenue – 

AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Cost Centre. 

Revenue – Department Text, max 3 

Characters 

Yes if Revenue – 

AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Department. 

AccruedReceipts – 

AccountNumber 

Text, max 8 

Characters 

No Must be a valid Sage 200 

Nominal Account Number. 

AccruedReceipts – 

CostCentre 

Text, max 3 

Characters 

Yes if 

AccruedReceipts 

– AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Cost Centre. 

AccruedReceipts – 

Department 

Text, max 3 

Characters 

Yes if 

AccruedReceipts 

– AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Department. 

Issues – AccountNumber Text, max 8 

Characters 

No Must be a valid Sage 200 

Nominal Account Number. 

Issues – CostCenter Text, max 3 

Characters 

Yes if Issues – 

AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Cost Centre. 

Issues – Department Text, max 3 

Characters 

Yes if Issues – 

AccountNumber 

is used 

Must be a valid Sage 200 

Nominal Department. 

Supplier Text, max 8 

Characters 

No Must be a valid Sage 200 

Supplier Account Number. 

SupplierLeadTime integer No  

SupplierLeadTimeUnit Text No Must be one of: Day(s), 

Week(s), Month(s) or Years(s) 

SupplierMinimumQuantity Decimal No  

SupplierOrderQuantity Decimal No  

SupplierPartNumber Text, max 40 

chars 

No  

AlternativeItem Text, max 30 

chars 

No Must be a valid Sage 200 

Stock Code. 

StockUnit Text, max 20 

characters 

No Must be a valid Sage 200 

stock unit. 

AverageBuyingPrice Decimal No Must be left blank for existing 

items. 
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Field Name Format Required Import Rules 

LastOrderPrice Decimal No Must be left blank for existing 

items. 

BarcodeNeeded Y/N No  

StandardCostPrice Decimal No  

SupplierCostPrice Decimal No  

StandardSellingPrice Decimal No  

LandedCostStockItemType Text No Must be one of: Value, 

Percentage or None 

LandedCostStockItem Decimal No Must be left blank if 

LandedCostStockItemType is 

None 

LandedCostSupplierType Text No Must be one of: Value, 

Percentage or None 

LandedCostSupplier Decimal No Must be left blank if 

LandedCostSupplierType is 

None 

Warehouse Text No  Must be a valid Sage 200 

warehouse.1 

Priceband Text No Must be a valid Sage 200 

priceband.  

PriceBandPrice Decimal No Required decimal value if 

Priceband is entered.  

PickingListComment Text, max 160 

Characters 

No  

DespatchComment Text, max 160 

Characters 

No  

StockItemStatus Text No Must be either “Active” or 

“Inactive” 

Barcode Text, max 30 

characters 

No  

AnalysisName\1 Text, Max 60 

characters 

No Must be a valid Sage 200 

Analysis Code name. See 

Note 2 

AnalysisName\2 Text, Max 60 

characters 

No Must be a valid Sage 200 

Analysis Code name. See 

Note 2 

AnalysisValue\1 Text, Max 60 

characters 

No Must be a valid value for the 

specified analysis Code. See 

Note 2 
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Field Name Format Required Import Rules 

AnalysisValue\2 Text, Max 60 

characters 

No Must be a valid value for the 

specified analysis Code. See 

Note 2 

 

• The values entered for AccountNumber, CostCenter and Department must be a valid 

Nominal Code within Sage 200. 

 

1. For multiple locations, warehouses should be entered in the following format: 

“Warehouse1|Warehouse2|Warehouse3” 

2. Up to 20 Analysis Codes can be specified by adding columns with increasing 
numbers. i.e. 

AnalysisName\2,AnalysisValue\2.....AnalysisName\20,AnalysisValue\20 

 

 

5.1.17. Stock Item Price Import 

 

Stock Item Prices CSV files should be created using the following field listing as guidance: 

 

Field Name Format Required Import Rules 

StockItem Text, max 30 

characters 

Yes Must be a valid Sage 200 Stock code. 

Priceband Text, max 20 

characters 

Yes Must be a valid Sage 200 priceband. 

Price Decimal Yes Must be a valid decimal 

UseStandard Y/N No If this is not specified then this will 

default to False. 

 

If this is False then the Price will be 

updated, otherwise if this is True then 

the Price in the file will be ignored and 

this will be set to the value of the 

Standard Price. 

 

Note this cannot be set to False on the 

Standard Band. 

 

 

5.1.18. Add Stock Import 

 

Add Stock CSV files should be created using the following field listing as guidance: 
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Field Name Format Required Import Rules 

StockCode Text, max 20 chars Yes Must be a valid Stock Code 

Location Text, max 20 chars Yes Must be a valid Warehouse 

Name 

Bin Text, max 20 chars Yes 1  

Qty Decimal Yes  

Price Decimal No  

Reference1 Text, max 20 chars No  

Reference2 Text, max 20 chars No  

ActivityDate dd/mm/yyyy No  

BatchSerialNo Text, max 30 chars  No Must be unique for items that 

do not allow duplicates 

BatchSerialAlternateRef Text, max 30 chars  No  

BatchSerialSellBy DD/MM/YYYY No  

BatchSerialUseBy DD/MM/YYYY No  

BatchAttributeTitle1 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle2 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle3 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle4 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle5 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle6 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle7 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle8 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle9 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle10 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle11 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle12 Text, max 60chars No Must be a valid attribute for 

this stock item 
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Field Name Format Required Import Rules 

BatchAttributeTitle13 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle14 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle15 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle16 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle17 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle18 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle19 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeTitle20 Text, max 60chars No Must be a valid attribute for 

this stock item 

BatchAttributeValue1 Text, max 60chars No  

BatchAttributeValue2 Text, max 60chars No  

BatchAttributeValue3 Text, max 60chars No  

BatchAttributeValue4 Text, max 60chars No  

BatchAttributeValue5 Text, max 60chars No  

BatchAttributeValue6 Text, max 60chars No  

BatchAttributeValue7 Text, max 60chars No  

BatchAttributeValue8 Text, max 60chars No  

BatchAttributeValue9 Text, max 60chars No  

BatchAttributeValue10 Text, max 60chars No  

BatchAttributeValue11 Text, max 60chars No  

BatchAttributeValue12 Text, max 60chars No  

BatchAttributeValue13 Text, max 60chars No  

BatchAttributeValue14 Text, max 60chars No  

BatchAttributeValue15 Text, max 60chars No  

BatchAttributeValue16 Text, max 60chars No  

BatchAttributeValue17 Text, max 60chars No  

BatchAttributeValue18 Text, max 60chars No  

BatchAttributeValue19 Text, max 60chars No  

BatchAttributeValue20 Text, max 60chars No  

 

If left blank it will default to Unspecified Bin also if the Bin does not already exist this will be 

created automatically by the import (only if enabled from the plugin settings). 
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5.1.19. Write Off Stock Import 

 

Write Off Stock CSV files should be created using the following field listing as guidance: 

 

Field Name Format Required Import Rules 

StockCode Text, max 20 chars Yes Must be a valid Stock Code 

Location Text, max 20 chars Yes Must be a valid Warehouse Name 

Bin Text, max 20 chars Yes If left blank it will default to Unspecified 

Bin 

Qty Decimal Yes  

Reference1 Text, max 20 chars No  

Reference2 Text, max 20 chars No  

ActivityDate dd/mm/yyyy No  

WriteOffCat Text, max 20 chars Yes Must be a valid Write Off Category 

BatchSerialNo Text, max 30 chars No Must be a valid Batch/Serial number for 

this item 

BatchSerialQuantity Decimal No  

 

5.1.20. Customer Delivery Address Import 

 

Customer Delivery Address files should be created using the following field listing as 

guidance: 

 

Field Name Format Required Import Rules 

CustomerCode Text, max 8 chars Yes Must be a valid Customer Reference 

Description Text, max 50 chars Yes Must be unique for this customer 

PostalName Text, max 60 chars No  

AddressLine1 Text, max 60 chars No  

AddressLine2 Text, max 60 chars No  

AddressLine3 Text, max 60 chars No  

AddressLine4 Text, max 60 chars No  

City Text, max 60 chars No  

County Text, max 60 chars No  

PostCode Text, max 10 chars No  

CountryCode Text, max 2 chars No Must be a Valid Country Code 

Contact Text, max 50 chars No  

Telephone Text, max 30 chars No  

Fax Text, max 30 chars No  

Email Text, max 255 

chars 

No  
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Field Name Format Required Import Rules 

TaxNumber Text, max 30 chars No  

TaxCode Integer No Must be a Valid Tax Code 

TaxCountryCode Text, max 2 chars No Must be a Valid Country Code 

 

5.1.21. Stock Transfer Import 

 

Stock Transfer files should be created using the following field listing as guidance: 

 

Field Name Format Required Import Rules 

StockCode Text, max 30 chars Yes Must be a valid stock code 

WarehouseFrom Text, max 20 chars Yes1 Must be a valid Warehouse for this stock 

item 

BinFrom Text, max 20 chars Yes Must be a valid Bin location for this stock 

item and warehouse combination. If left 

blank it will default to Unspecified Bin 

WarehouseTo Text, max 20 chars Yes1 Must be a valid Warehouse for this stock 

item 

BinTo Text, max 20 chars Yes Must be a valid Bin location for this stock 

item and warehouse combination. If left 

blank it will default to Unspecified Bin 

TotalQuantity Decimal Yes  

Reference1 Text, max 20 chars No  

Reference2 Text, max 20 chars No  

TransferDate Date No2 If left blank will default to current system 

date 

BatchSerialNo Text, max 30 chars No  

BatchSerialQuantity Decimal No  

 

1. If left blank it will default to Unspecified Bin 

 

2. If left blank will default to today’s date 

 

1. When transferring Batch / Serial Numbered items the fields shown above in bold are 
header fields. Where these are identical for multiple consecutive lines in the import 
file the import routine treats the lines as being part of the same batch/serial transfer. 
In this scenario the Total Quantity field must be the total of all of these items being 
received. 
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5.1.22. Stock Issue Import 

 

Stock Transfer files should be created using the following field listing as guidance: 

 

Field Name Format Required Import Rules 

StockCode Text, max 30 chars Yes Must be a valid stock code 

WarehouseFrom Text, max 20 chars Yes Must be a valid Warehouse for this 

stock item 

BinFrom Text, max 20 chars Yes 1 Must be a valid Bin location for this 

stock item and warehouse 

combination. 

InternalArea Text, max 20 chars No 2  

TotalQuantity Decimal Yes  

Reference1 Text, max 20 chars No  

Reference2 Text, max 20 chars No  

IssueDate DD/MM/YYYY No 3  

Memo Text, max 5000 

chars 

No  

Narrative Text, max 60 chars No  

StockNominalAccountRef Text, max 8 chars No Must be a valid Sage 200 Nominal 

Account Number. 

StockNominalCostCentre Text, max 3 chars No Must be a valid Sage 200 Nominal 

Cost Centre. 

StockNominalDepartment Text, max 3 chars No Must be a valid Sage 200 Nominal 

Department. 

IssueNominalAccountRef Text, max 8 chars No Must be a valid Sage 200 Nominal 

Account Number. 

IssueNominalCostCentre Text, max 3 chars No Must be a valid Sage 200 Nominal 

Cost Centre. 

IssueNominalDepartment Text, max 3 chars No Must be a valid Sage 200 Nominal 

Department. 

AnalysisName\1 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\2 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\3 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\4 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\5 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 
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Field Name Format Required Import Rules 

AnalysisName\6 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\7 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\8 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\9 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\10 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\11 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\12 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\13 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\14 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\15 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\16 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\17 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\18 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\19 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisName\20 Text, max 60 chars No  Must be a valid Analysis Code for 

this Stock Transaction 

AnalysisValue\1 Text, max 60 chars No   

AnalysisValue\2 Text, max 60 chars No   

AnalysisValue\3 Text, max 60 chars No   

AnalysisValue\4 Text, max 60 chars No   

AnalysisValue\5 Text, max 60 chars No   

AnalysisValue\6 Text, max 60 chars No   

AnalysisValue\7 Text, max 60 chars No   

AnalysisValue\8 Text, max 60 chars No   

AnalysisValue\9 Text, max 60 chars No   

AnalysisValue\10 Text, max 60 chars No   
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Field Name Format Required Import Rules 

AnalysisValue\11 Text, max 60 chars No   

AnalysisValue\12 Text, max 60 chars No   

AnalysisValue\13 Text, max 60 chars No   

AnalysisValue\14 Text, max 60 chars No   

AnalysisValue\15 Text, max 60 chars No   

AnalysisValue\16 Text, max 60 chars No   

AnalysisValue\17 Text, max 60 chars No   

AnalysisValue\18 Text, max 60 chars No   

AnalysisValue\19 Text, max 60 chars No   

AnalysisValue\20 Text, max 60 chars No   

BatchSerialNo Text, max 30 chars No  

BatchSerialQuantity Decimal No  

 
1. If left blank it will default to Unspecified Bin 

 
2. If left blank it will use the Default Internal Area 

 
3. If  left blank will default to today’s date 

 

• When Issuing Batch/Serial Numbered items, the fields shown above in bold are 
header fields. Where these are identical for multiple consecutive lines in the import 
file the import routine treats the lines as being part of the same batch/serial issue. In 
this scenario the Total Quantity field must be the total of all of these items being 
issued. 

 

5.1.23. Sales Order Batch/Serial Allocations 

 

 

Sales Order Batch/Serial Allocation files should be created using the following field listing as 

guidance: 

 

Field Name Format Required Import Rules 

SalesOrderNumber Text, max 30 chars Yes Must be a valid sales order number 

StockItemCode Text, max 20 chars Yes Must be a valid stock item for the 

above sales order 

BatchSerialNo Text, max 20 chars Yes  Must be a valid Batch/Serial 

number for this item 

Quantity Text, max 20 chars Yes  
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5.1.24. Product Group / Item Discount Import 

 

This allows Product Group and Stock Item discounts to be imported into Sage 200. 

 

 

Field Name Format Required Import Rules 

DiscountVersion Integer Yes 1 = Stock Item, 2 = Product group 

Code Text, max 20 

chars 

Yes Must be valid Item Code/Product Group 

Depending on Version 

DiscountName Text, max 50 

chars 

Yes  

SellingUnit Text, Default Each No Required if Stock item Discount 

DiscountType Text, max 10 

chars 

Yes Must be a valid discount type: 

Percentage 

Amount 

Special Price 

(Product Group Discount can only be 

Percentage) 

QuantityBreakDiscount Yes / No No If “No” or left blank discount will be 

applied as a Flat-Rate discount 

Quantity Decimal No Required if Quantity Break discount 

DiscountValue Decimal Yes  

Currency Text, max 3 chars No Must be a valid Sage currency ISO 

code and entered if stock item discount 

- Amount or Special Price. 

 

• Multiple quantity break discounts for a specific item or product group should be 

entered as consecutive lines within the import file and the bold header fields must be 

identical for each line of the discount.   

• To create a quantity break surcharge, the DiscountValue field should be negative.  

 

5.1.25. Customer Discount Group Import 

 

This allows Customer Discount groups to be imported into Sage 200. 

 

Field Name Format Required Import Rules 

DiscountGroup Text, max 20 chars Yes Must be unique 

Description Text, max 50 chars Yes  
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5.1.26. Customer Contact Import 

 

This allows Customer Contacts to be imported into Sage 200. 

 

 

5.1.27. Link Customer to Discount Group Import 

 

This allows Customers to be linked to Discount Groups Sage 200. 

 

Field Name Format Required Import Rules 

DiscountGroup Text, max 20 chars Yes Must be valid discount group 

CustAccRef Text, max 8 chars Yes Must be valid customer 

 

5.1.28. Link Product Group/Item Discount to Customer Discount Group 

 

This allows Product Groups and Stock Item Discounts to be linked to Discount Groups in 

Sage 200. 

 

Field Name Format Required Import Rules 

DiscountVersion Integer Yes 1 = Stock Item, 2 = Product group 

DiscountGroup Text, max 20 chars Yes Must be valid discount group 

Code Text, max 50 chars Yes Must be valid product group/ItemCode 

DiscountName Text, max 50 chars Yes Must be valid discount name 

Field Name Format Required Import Rules 

SLCustomerAccountRef Text, max 8 chars Yes  

Description Text, max 50 chars No  

Salutation Text, max 50 chars No Must be a valid Salutation in Sage 200 

FirstName Text, max 60 chars Yes  

MiddleName Text, max 60 chars Yes  

LastName Text, max 60 chars Yes  

Role1 Text, max 50 chars No Must be a valid role in Sage 200 

IsPreferredRole1 Boolean No  

ContactType1 Text, max 20 chars No Must be a valid Contact Type Number, 

see below 

ContactValue1 Text, max 227 chars No  

IsPreferredContact1 Boolean No  

CountryCode Text, max 5 chars No  

AreaCode Text, max 20 chars No  

SubscriberNumber Text, max 200 chars No  
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5.1.29. Tax Only Invoice Import 

 

This allows Tax Only Invoices to be imported into Sage 200. 

 

Field Name Format Required Import Rules 

CustomerAccRef Text, max 8 

characters. 

Yes Must be a valid Sage 200 customer 

reference. 

InvoiceDate dd/mm/yyyy No Defaults to today’s date if blank. 

SecondRef Text, max 20 

characters. 

No  

InvoiceLineDescription Text Yes  

TaxRate Integer  Yes Must be a valid Sage 200 Tax Code 

TaxValue Decimal Yes  

 

 

For invoices with multiple lines, the lines should be placed consecutively in the file with 

identical bold header fields.  
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5.2. Export Files 

 

The following Export file formats are intended as a guide only.  For the most up to date 

version please check the Templates folder in the Data Exchange installation directory. 

i.e. C:\Program Files\Eureka Solutions\Data Exchange\Templates. 

 

There should be a number of files there for each plugin.  The .doc file will contain the up to 

date version of the tables below. 

 

5.2.1. Country Code Export 

 

Field Name Format Rules 

Code Text, max 2 chars  

Name Text, max 60 chars  

 

5.2.2. Email Address Export 

 

Field Name Format Rules 

AccountRef Text, max 8 chars  

EmailAddress Text, max 227 chars  

 

5.2.3. Nominal Code 

 

Field Name Format Rules 

AccountRef Text, max 8 chars  

CostCentre Text, max 3 chars  

Department Text, max 3 chars  

Name Text, max 60 chars  

 

5.2.4. Product Group Export 

 

Field Name Format Rules 

Code Text, max 20 chars  

Description Text, max 50 chars  

StockItemType Text, max 20 chars  

CostingMethod Text, max 8 chars  

StockTakeDays Integer, max 2 digits  
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Field Name Format Rules 

LabelPrinting Integer 0 - Label not required 

1 - Label required per item 

2 - Label required per batch 

MaintainHistory True/False  

AllowNegativeStock True/False  

DescriptionOnDocs True/False  

ReverseChargeVAT True/False  

TraceableItems Text, max 15 chars  

DoItemsUseUnits True/False  

MarkupPercent Decimal  

SellQuantsUseMultUnits True/False  

BuyQuantsUseMultUnits True/False  

SellPricesUseMultUnits True/False  

BuyPricesUseMultUnits True/False  

ThisIsTheSOPProductGroup True/False  

SaleFromSingleBatch True/False  

AllowDuplicateNumbers True/False  

UsesAlternateRef True/False  

UsesSellByDate True/False  

UsesUseByDate True/False  

LastTraceArchivedUpTo Date,  dd/mm/yyyy  

UseLandedCosts True/False  

LandedCostsType Text, max 16 chars  

LandedCostsValue Decimal  

 

5.2.5. Purchase Order Export 

 

Field Name Format Rules 

OrderType Integer 1 – Purchase Order 

2 – Purchase Return 

OrderNumber Text, max 20 chars  

OrderStatus Text, max 20 chars  

SuppAccRef Text, max 8 chars  

OrderDate Date, dd/mm/yyyy  

OrderRequestedDate Date, dd/mm/yyyy  

LineType Integer 1 - Stock Item 

2 - Free Text Item 

3 - Charge 

4 - Comment 
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Field Name Format Rules 

ProductCode Text, max 30 chars  

ProductDescription Text,   

Warehouse Text, max 20 chars  

Quantity Decimal  

UnitPrice Decimal  

BuyingUnit Decimal  

TotalValue Decimal  

TaxCode Integer, 2 digits  

TaxAmount Decimal  

DiscountPercent Decimal  

DiscountValue Decimal  

NominalCode Text, max 8 chars  

CostCentre Text, max 3 chars  

Department Text, max 3 chars  

ShowOnSuppDocs Integer  0 – False 

1 - True 

SupplierDocumentNumber Text, max 50 chars  

AnalysisCodeName1 Text, max 60 characters  

AnalysisCodeName2 Text, max 60 characters  

AnalysisCodeName3 Text, max 60 characters  

AnalysisCodeName4 Text, max 60 characters  

AnalysisCodeName5 Text, max 60 characters  

AnalysisCodeName6 Text, max 60 characters  

AnalysisCodeName7 Text, max 60 characters  

AnalysisCodeName8 Text, max 60 characters  

AnalysisCodeName9 Text, max 60 characters  

AnalysisCodeName10 Text, max 60 characters  

AnalysisCodeName11 Text, max 60 characters  

AnalysisCodeName12 Text, max 60 characters  

AnalysisCodeName13 Text, max 60 characters  

AnalysisCodeName14 Text, max 60 characters  

AnalysisCodeName15 Text, max 60 characters  

AnalysisCodeName16 Text, max 60 characters  

AnalysisCodeName17 Text, max 60 characters  

AnalysisCodeName18 Text, max 60 characters  

AnalysisCodeName19 Text, max 60 characters  

AnalysisCodeName20 Text, max 60 characters  

AnalysisCodeValue1 Text, max 60 characters  

AnalysisCodeValue2 Text, max 60 characters  
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Field Name Format Rules 

AnalysisCodeValue3 Text, max 60 characters  

AnalysisCodeValue4 Text, max 60 characters  

AnalysisCodeValue5 Text, max 60 characters  

AnalysisCodeValue6 Text, max 60 characters  

AnalysisCodeValue7 Text, max 60 characters  

AnalysisCodeValue8 Text, max 60 characters  

AnalysisCodeValue9 Text, max 60 characters  

AnalysisCodeValue10 Text, max 60 characters  

AnalysisCodeValue11 Text, max 60 characters  

AnalysisCodeValue12 Text, max 60 characters  

AnalysisCodeValue13 Text, max 60 characters  

AnalysisCodeValue14 Text, max 60 characters  

AnalysisCodeValue15 Text, max 60 characters  

AnalysisCodeValue16 Text, max 60 characters  

AnalysisCodeValue17 Text, max 60 characters  

AnalysisCodeValue18 Text, max 60 characters  

AnalysisCodeValue19 Text, max 60 characters  

AnalysisCodeValue20 Text, max 60 characters  

LineAnalysisCode1 Text, max 60 characters  

LineAnalysisCode2 Text, max 60 characters  

LineAnalysisCode3 Text, max 60 characters  

LineAnalysisCode4 Text, max 60 characters  

LineAnalysisCode5 Text, max 60 characters  

LineAnalysisCode6 Text, max 60 characters  

LineAnalysisCode7 Text, max 60 characters  

LineAnalysisCode8 Text, max 60 characters  

LineAnalysisCode9 Text, max 60 characters  

LineAnalysisCode10 Text, max 60 characters  

LineAnalysisCode11 Text, max 60 characters  

LineAnalysisCode12 Text, max 60 characters  

LineAnalysisCode13 Text, max 60 characters  

LineAnalysisCode14 Text, max 60 characters  

LineAnalysisCode15 Text, max 60 characters  

LineAnalysisCode16 Text, max 60 characters  

LineAnalysisCode17 Text, max 60 characters  

LineAnalysisCode18 Text, max 60 characters  

LineAnalysisCode19 Text, max 60 characters  

LineAnalysisCode20 Text, max 60 characters  
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5.2.6. Sales Account Export 

 

Field Name Format Rules 

AccountNumber Text, max 8 chars  

AccountName Text, max 60 chars  

ShortName Text, max 8 chars  

AccountBalance Decimal  

CreditLimit Decimal  

CurrencyISOCode Text, max 3 chars  

SYSExchangeRateType Integer  

CountryCode Text, max 2 chars  

TaxCode Integer, max 2 digits  

TaxRegistrationNumber Text, max 30 chars  

MonthsToKeepTransactionsFor Integer, max 2 digits  

DefaultOrderPriority Text, max 1 char  

FinanceCharge Integer, max 5 digits  

DefaultNominalAccountNumber Text, max 8 chars  

DefaultNominalCostCentre Text, max 3 chars  

DefaultNominalDepartment Text, max 3 chars  

SYSAccountType Integer  

EarlySettlementDiscountPercent Decimal  

DaysEarlySettlementDiscountApplies Integer, max 3 digits  

PaymentTermsInDays Integer, max 3 digits  

SYSPaymentTermsBasis Integer  

UseConsolidatedBilling Integer 0 - False 

1- True 

InvoiceLineDiscountPercent Decimal  

InvoiceDiscountPercent Decimal  

SendCopyStatementToBranch Integer 0 - False 

1 - True 

AccountIsOnHold Integer 0 - False 

1- True 

ValueOfCurrentOrdersInSOP Decimal  

DateAccountDetailsLastChanged Date, dd/mm/yyyy  

DateOfLastTransaction Date, dd/mm/yyyy  

EuroAccountNumberCopiedFromTo Text, max 8 chars  

DateEuroAccountCopied Date, dd/mm/yyyy  

UseTransactionEMail Integer 0 - False 

1- True 
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Field Name Format Rules 

TransactionEMail Text, max 227 chars  

ContactName Text, max 235 chars  

TelephoneNumber Text, max 200 chars  

FaxNumber Text, max 200 chars  

AddressLine1 Text, max 60 chars  

AddressLine2 Text, max 60 chars  

AddressLine3 Text, max 60 chars  

AddressLine4 Text, max 60 chars  

PostCode Text, max 10 chars  

DateFinanceChargeLastRun Date, dd/mm/yyyy  

AssociatedOfficeType Integer 0 – Independent 

1 – Branch 

2 – Head Office 

3 – Independent No Statement 

4 – Head Office No Statement 

AssociatedHeadOfficeAccountNum Text, max 8 chars  

TradingTerms Text, max 30 chars  

CreditReference Text, max 60 chars  

CreditBureau Text, max 50 chars  

CreditPosition Text, max 50 chars  

TermsAgreed Integer 0 - False 

1- True 

AccountOpened Date, dd/mm/yyyy  

LastCreditReview Date, dd/mm/yyyy  

NextCreditReview Date, dd/mm/yyyy  

ApplicationDate Date, dd/mm/yyyy  

DateReceived Date, dd/mm/yyyy  

PriceBand Text, max 20 characters  

AnalysisName1 … 20 Text, max 30 characters  

AnalysisValue1 … 20 Text, max 30 characters  

SpareText1 Text, max 100 chars  

SpareText2 Text, max 100 chars  

SpareText3 Text, max 100 chars  

SpareNumber1 Decimal  

SpareNumber2 Decimal  

SpareNumber3 Decimal  

SpareDate1 Date, dd/mm/yyyy  

SpareDate2 Date, dd/mm/yyyy  

SpareDate3 Date, dd/mm/yyyy  

SpareBit1 True/False  
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Field Name Format Rules 

SpareBit2 True/False  

SpareBit3   True/False  

 

5.2.7. Sales Order Export 

 

Field Name Format Rules 

OrderType Integer  0- Sales Return 

1- Sales Order 

OrderNumber Text, max 20 chars  

CustAccRef Text, max chars  

OrderDate Date, dd/mm/yyyy  

OrderRequestedDate Date, dd/mm/yyyy  

OrderPromisedDate Date, dd/mm/yyyy  

PaymentInFull Yes/No  

PaymentValue Decimal  

PaymentRef Text, max 20 chars  

PaymentMethod Text, max 20 chars  

CustomerOrderNumber Text, max 30 chars  

DelPostalName Text, max 60 chars  

DelAddressLine1 Text, max 60 chars  

DelAddressLine2 Text, max 60 chars  

DelAddressLine3 Text, max 60 chars  

DelAddressLine4 Text, max 60 chars  

DelCity Text, max 60 chars  

DelCounty Text, max 60 chars  

DelPostcode Text, max 10 chars  

DelContact Text, max 50 chars  

DelTelephone Text, max 30 chars  

DelFax Text, max 30 chars  

DelEmail Text, max 225 chars  

DelTaxNumber Text, max 30 chars  

DelTaxCode Integer, max 2 digits  

UseInvoiceAddress True/False  

InvoicePostalName Text, max 60 chars  

InvoiceAddressLine1 Text, max 60 chars  

InvoiceAddressLine2 Text, max 60 chars  

InvoiceAddressLine3 Text, max 60 chars  

InvoiceAddressLine4 Text, max 60 chars  

InvoiceCity Text, max 60 chars  
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Field Name Format Rules 

InvoiceCounty Text, max 60 chars  

InvoicePostCode Text, max 10 chars  

InvoiceCountry Text, max 60 chars  

DelCountryCode Text, max 2 digits  

OrderSpareText1 Text, max 100 chars  

OrderSpareText2 Text, max 100 chars  

OrderSpareText3 Text, max 100 chars  

OrderSpareNumber1 Decimal  

OrderSpareNumber2 Decimal  

OrderSpareNumber3 Decimal  

OrderSpareDate1 Date, dd/mm/yyyy  

OrderSpareDate2 Date, dd/mm/yyyy  

OrderSpareDate3 Date, dd/mm/yyyy  

OrderSpareBit1 True/False  

OrderSpareBit2 True/False  

OrderSpareBit3 True/False  

OrderLineRequestedDate Date, dd/mm/yyyy  

OrderLinePromisedDate Date, dd/mm/yyyy  

LineType Integer 1 – Stock item 

2 – Free text item 

3 – Additional charge item 

4 – Comment line 

5 – SOP item code 

ProductCode Text, max 30 chars  

ProductDescription Text, max 255 chars  

Warehouse Text, max 20 chars  

Quantity Decimal  

UnitPrice Decimal  

TotalValue Decimal  

TaxCode Integer, max 2 digits  

TaxAmount Decimal  

DiscountPercent Decimal  

DiscountValue Decimal  

NominalCode Text, max 8 chars  

CostCentre Text, max 3 chars  

Department Text, max 3 chars  

ShowOnPickingList Integer 0 – False 

1 - True 

ShowOnCustDocs Integer 0 – False 

1 – True 
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Field Name Format Rules 

LineSpareText1 Text, max 100 chars  

LineSpareText2 Text, max 100 chars  

LineSpareText3 Text, max 100 chars  

LineSpareNumber1 Decimal  

LineSpareNumber2 Decimal  

LineSpareNumber3 Decimal  

LineSpareDate1 Date, dd/mm/yyyy  

LineSpareDate2 Date, dd/mm/yyyy  

LineSpareDate3 Date, dd/mm/yyyy  

LineSpareBit1 True/False  

LineSpareBit2 True/False  

LineSpareBit3 True/False  

AnalysisCode1 Text, max 30 characters  

AnalysisCode2 Text, max 30 characters  

AnalysisCode3 Text, max 30 characters  

AnalysisCode4 Text, max 30 characters  

AnalysisCode5 Text, max 30 characters  

AnalysisCode6 Text, max 30 characters  

AnalysisCode7 Text, max 30 characters  

AnalysisCode8 Text, max 30 characters  

AnalysisCode9 Text, max 30 characters  

AnalysisCode10 Text, max 30 characters  

AnalysisCode11 Text, max 30 characters  

AnalysisCode12 Text, max 30 characters  

AnalysisCode13 Text, max 30 characters  

AnalysisCode14 Text, max 30 characters  

AnalysisCode15 Text, max 30 characters  

AnalysisCode16 Text, max 30 characters  

AnalysisCode17 Text, max 30 characters  

AnalysisCode18 Text, max 30 characters  

AnalysisCode19 Text, max 30 characters  

AnalysisCode20 Text, max 30 characters  

LineAnalysisCode1 Text, max 30 characters  

LineAnalysisCode2 Text, max 30 characters  

LineAnalysisCode3 Text, max 30 characters  

LineAnalysisCode4 Text, max 30 characters  

LineAnalysisCode5 Text, max 30 characters  

LineAnalysisCode6 Text, max 30 characters  

LineAnalysisCode7 Text, max 30 characters  
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Field Name Format Rules 

LineAnalysisCode8 Text, max 30 characters  

LineAnalysisCode9 Text, max 30 characters  

LineAnalysisCode10 Text, max 30 characters  

LineAnalysisCode11 Text, max 30 characters  

LineAnalysisCode12 Text, max 30 characters  

LineAnalysisCode13 Text, max 30 characters  

LineAnalysisCode14 Text, max 30 characters  

LineAnalysisCode15 Text, max 30 characters  

LineAnalysisCode16 Text, max 30 characters  

LineAnalysisCode17 Text, max 30 characters  

LineAnalysisCode18 Text, max 30 characters  

LineAnalysisCode19 Text, max 30 characters  

LineAnalysisCode20 Text, max 30 characters  

 

 

5.2.8. Sales Invoice Export 

 

Field Name Format Rules 

SalesInvoiceNumber Text, max 20 characters  

SalesOrderNumber Text, max 20 characters  

CustomerAccRef Text, max 19 characters  

DocumentDate Date  

StockItemCode Text, max 30 characters  

Quantity Decimal, max 15 characters  

IsConsolidated Boolean  

ItemDescription Text  

InvoicedTaxValue Decimal, max 12 characters  

LineVATAmount Decimal, max 12 characters  

LineTotalAmount Decimal, max 12 characters  

ItemPrice Decimal, max 12 characters  

ItemName Text  

OutstandingQuantity Decimal, max 15 characters  

LineDiscountPercent Decimal, max 15 characters  

 

5.2.9. Stock Item Export 

 

Field Name Format Rules 

StockItemCode Text, max 30 chars  
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Field Name Format Rules 

StockItemName Text, max 60 chars  

ProductGroup Text, max 50 chars  

TaxCode Integer, max 2 digits  

StockItemDescription Text, max 255 chars  

ManufacturersName Text, max 40 chars  

ManufacturersPartNumber Text, max 40 chars  

CommodityCode Text, max 8 chars  

NetMass Decimal  

StockTakeDays Integer, max 3 chars  

AssetOfStock - AccountNumber Text, max 8 chars  

AssetOfStock - CostCentre Text, max 3 chars  

AssetOfStock - Department Text, max 3 chars  

Revenue - AccountNumber Text, max 8 chars  

Revenue - CostCentre Text, max 3 chars  

Revenue - Department Text, max 3 chars  

AccruedReceipts - AccountNumber Text, max 8 chars  

AccruedReceipts - CostCentre Text, max 3 chars  

AccruedReceipts - Department Text, max 3 chars  

Issues - AccountNum Text, max 8 chars  

Issues - CostCentre Text, max 3 chars  

Issues - Department Text, max 3 chars  

Supplier Text, max 8 chars  

SupplierLeadTime Integer, max 5 chars  

SupplierLeadTimeUnit Text, max 8 chars  

SupplierMinimumQuantity Decimal  

SupplierOrderQuantity Decimal  

SupplierPartNumber Text, max 40 chars  

AlternativeItem Text, max 30 chars  

AlternativeItemName Text, max 60 chars  

StockUnit Text, max 20 char  

AverageBuyingPrice Decimal  

LastOrderPrice Decimal  

BarCodeNeeded Y/N  

StandardCostPrice Decimal  

SupplierCostPrice Decimal  

StandardSellingPrice Decimal  

LandedCostStockItemType Text, max 10 chars  

LandedCostStockItem Decimal  

LandedCostSupplierType Text, max 10 chars  
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Field Name Format Rules 

LandedCostSupplier Decimal  

AllowSalesOrder Y/N  

Active Y/N  

SpareText1 Text, max 100 chars  

SpareText2 Text, max 100 chars  

SpareText3 Text, max 100 chars  

SpareNumber1 Decimal  

SpareNumber2 Decimal  

SpareNumber3 Decimal  

SpareDate1 Date, dd/mm/yyyy  

SpareDate2 Date, dd/mm/yyyy  

SpareDate3 Date, dd/mm/yyyy  

SpareBit1 True/False  

SpareBit2 True/False  

SpareBit3   True/False  

Warehouse – ‘WarehouseName’ Y/N This will loop through all 

warehouses outputting whether 

or not the item is in this 

warehouse. 

Price – ‘PriceBandName’ Decimal This will loop through all Price 

Bands outputting the price for 

each band. 

PickingListComment Text  

DespatchComment Text  

StockItemStatus Text  

 

5.2.10. Stock Level Export 

 

Field Name Format Rules 

StockItem Text, max 30 chars  

StockItemName Text, max 60 chars  

Warehouse Text, max 20 chars  

StockLevel Decimal  

QuantityOnOrder Decimal  

QuantityInStock Decimal  

QuantityAllocated Decimal  

FreeStock Decimal  

AnalysisName1 Text, max 60 characters  

AnalysisValue1 Text, max 60 characters  
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Field Name Format Rules 

AnalysisName2 Text, max 60 characters  

AnalysisValue2 Text, max 60 characters  

AnalysisName3 Text, max 60 characters  

AnalysisValue3 Text, max 60 characters  

AnalysisName4 Text, max 60 characters  

AnalysisValue4 Text, max 60 characters  

AnalysisName5 Text, max 60 characters  

AnalysisValue5 Text, max 60 characters  

AnalysisName6 Text, max 60 characters  

AnalysisValue6 Text, max 60 characters  

AnalysisName7 Text, max 60 characters  

AnalysisValue7 Text, max 60 characters  

AnalysisName8 Text, max 60 characters  

AnalysisValue8 Text, max 60 characters  

AnalysisName9 Text, max 60 characters  

AnalysisValue9 Text, max 60 characters  

AnalysisName10 Text, max 60 characters  

AnalysisValue10 Text, max 60 characters  

AnalysisName11 Text, max 60 characters  

AnalysisValue11 Text, max 60 characters  

AnalysisName12 Text, max 60 characters  

AnalysisValue12 Text, max 60 characters  

AnalysisName13 Text, max 60 characters  

AnalysisValue13 Text, max 60 characters  

AnalysisName14 Text, max 60 characters  

AnalysisValue14 Text, max 60 characters  

AnalysisName15 Text, max 60 characters  

AnalysisValue15 Text, max 60 characters  

AnalysisName16 Text, max 60 characters  

AnalysisValue16 Text, max 60 characters  

AnalysisName17 Text, max 60 characters  

AnalysisValue17 Text, max 60 characters  

AnalysisName18 Text, max 60 characters  

AnalysisValue18 Text, max 60 characters  

AnalysisName19 Text, max 60 characters  

AnalysisValue19 Text, max 60 characters  

AnalysisName20 Text, max 60 characters  

AnalysisValue20 Text, max 60 characters  
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5.2.11. Stock Item Price Export 

 

Field Name Format Rules 

StockItemCode Text, max 30 chars  

PricebandName Text, max 20 chars  

Price Decimal  

Currency Text, 3 chars  

UseStandard True/False  

 

5.2.12. Supplier Account Export 

 

Field Name Format Rules 

AccountNumber Text, max 8 chars  

AccountName Text, max 60 chars  

ShortName Text, max 8 chars  

AccountBalance Decimal  

CreditLimit Decimal  

CurrencyISOCode Text, max 3 chars  

SYSExchangeRateType Integer  

CountryCode Text, max 2 chars  

TaxCode Integer, max 2 digits  

TaxRegistrationCode Text, max 30 chars  

MonthsToKeepTransactionsFor Integer, max 2 digits  

DefaultOrderPriority Text, max 1 char  

DefaultNominalAccountNumber Text, max 8 chars  

DefaultNominalCostCentre Text, max 3 chars  

DefaultNominalDepartment Text, max 3 chars  

SYSAccountType Integer  

PLPaymentGroup Integer  

EarlySettlementDiscountPercent Decimal  

DaysEarlySettlementDiscountApplies Integer, max 3 digits  

PaymentTermsInDays Integer, max 3 digits  

SYSPaymentTermsBasis Integer  

AccountIsOnHold Integer 0 – False 

1 - True 

ValueOfCurrentOrdersInPOP Decimal  

DateAccountDetailsLastChanged Date, dd/mm/yyyy  

DateOfLastTransaction Date, dd/mm/yyyy  

EuroAccountNumberCopiedFromTo Text, max 8 chars  

DateEuroAccountCopied Date, dd/mm/yyyy  
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Field Name Format Rules 

UseTransactionEMail Integer 0 – False 

1 - True 

TransactionEMail Text, max 227 chars  

ContactName Text, max 235 chars  

TelephoneNumber Text, max 200 chars  

FaxNumber Text, max 200 chars  

AddressLine1 Text, max 60 chars  

AddressLine2 Text, max 60 chars  

AddressLine3 Text, max 60 chars  

AddressLine4 Text, max 60 chars  

City Text, max 60 characters  

County  Text, max 60 characters  

PostCode Text, max 10 chars  

TradingTerms Text, max 30 chars  

CreditReference Text, max 60 chars  

CreditBureau Text, max 50 chars  

CreditPosition Text, max 50 chars  

TermsAgreed Integer 0 – False 

1 - True 

AccountOpened Date, dd/mm/yyyy  

LastCreditReview Date, dd/mm/yyyy  

NextCreditReview Date, dd/mm/yyyy  

ApplicationDate Date, dd/mm/yyyy  

DateReceived Date, dd/mm/yyyy  

 

5.2.13. Supplier Bank Details Export 

 

Field Name Format Rules 

SupplierCode Text, max 8 chars  

SortCode Text, max 10 chars  

AccountNumber Text, max 20 chars  

AccountName Text, max 60 chars  

BankPaymentRef Text, max 60 chars  

PaymentGroup Integer, max 5 digits  

 

5.2.14. Image Export 

 

This allows images to be copied from one folder to another, i.e. from a folder on the network 

up to an FTP server to display on a website.   
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The settings can be configured by selecting Edit >Other plugins > Image Export: 

 

 
 

The Source and Export folder locations are specified. If the New / Changed Records only 

option is selected, any files that have changed since the last run will be copied to the export 

folder specified. Otherwise, a full export will be produced.  

 

5.2.15. PDF Export 

 

This allows PDF files to be copied from one folder to another, i.e. from a folder on the 

network up to an FTP server.   

 

The settings can be configured by selecting Edit >Other plugins > PDF Export: 

 

 
 

The Source and Export folder locations are specified. If the New / Changed Records only 

option is selected, any files that have changed since the last run will be copied to the export 

folder specified. Otherwise, a full export will be produced.  
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5.2.16. Product Discount Group Export 

 

Field Name Format Rules 

ProductGroup Text, max 20 chars  

Description Text, max 50 chars  

DiscountName Text, max 50 chars  

StockQuantity Decimal  

Discount Decimal  

Surcharge Decimal  

 

5.2.17. Stock Item Discount Export 

 

Field Name Format Rules 

StockCode Text, max 30 chars  

StockName Text, max 60 chars  

ProductGroup Text, max 20 chars  

StockQuantity Decimal  

ItemDiscount Text, max 50 chars  

SalesUnit Text, max 20 chars  

Currency Text, max 30 chars  

DiscountType Text, max 20 chars  

DiscountValue Decimal  

PercentageSurcharge Decimal  

 

5.2.18. Customer Discount Group Export 

 

Field Name Format Rules 

DiscountGroup Text, max 20 chars  

Description Text, max 50 chars  

CustAccRef Text, max 8 chars  

CustomerName Text, max 60 chars  

PriceBand Text, max 20 chars  

 

5.2.19. Customer Contact Export 

 

Field Name Format Rules 

SLCustomerAccountRef Text, max 8 chars  

ContactName Text, max 235 chars  

Description Text, max 50 chars  
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Field Name Format Rules 

Salutation Text, max 50 chars  

FirstName Text, max 60 chars  

MiddleName Text, max 60 chars  

LastName Text, max 60 chars  

Role1 Text, max 50 chars  

IsPreferredRole1 Boolean  

ContactType1 Text, max 20 chars Outputs Contact Type Number, see 

below 

ContactValue1 Text, max 227 chars  

IsPreferredContact1 Boolean  

CountryCode1 Text, max 5 chars  

AreaCode1 Text, max 20 chars  

SubscriberNumber1 Text, max 200 chars  

 

5.2.20. Order Value Discounts Export 

 

Field Name Format Rules 

OrderValueDiscount Text, max 20 chars  

Description Text, max 50 chars  

Currency Text, max 30 chars  

Value Decimal  

Discount Decimal  

Surcharge Decimal  

 

5.2.21. Price Band Export 

 

Field Name Format Rules 

PriceBand Text, max 20 chars  

Currency Text, max 30 chars  

Description Text, max 50 chars  

 

5.2.22. Sales Transaction Export 

 

Field Name Format Rules 

TransType Text, max 30 characters  

Reference Text, max 20 characters  

SecondReference Text, max 20 characters  

CustAccRef Text, max 8 characters  
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Field Name Format Rules 

CustomerBalance Decimal  

CustomerCreditLimit Decimal  

TransDate Date  

DueDate Date  

DiscountDate Date  

Value  Decimal  

DiscountPercentage Decimal  

DiscountedValue Decimal  

Allocated Decimal  

Outstanding Decimal  

OrigExRate Decimal  

Query Text, max 1 characters  

Status Text, max 20 characters  

Memo Text, max 60 characters  

User Text, max 20 characters  

Source Text, max 30 characters  

URN BigInt  

TaxValue Decimal  

FullSettlementDate Date  

FullSettlementPeriodInDays Int  

Revalued Bool  

EffectiveExchangeRate Int  

PostedDate Date  

 

5.2.23. Search Category Export 

 

Field Name Format Rules 

StockItemCode Text, max 30 characters  

SearchCategoryName1 

 

 These fields are dynamically 

named based on the search 

category. The search category 

names used will depend on how 

it is set up in sage 200. 
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5.2.24 Customer Delivery Address Export 

Field Name Format Rules 

CustomerCode Text, max 8 characters  

Description Text, max 255 characters  

PostalName Text, max 60 characters  

AddressLine1 Text, max 60 characters  

AddressLine2 Text, max 60 characters  

AddressLine3 Text, max 60 characters  

AddressLine4 Text, max 60 characters  

City Text, max 60 characters  

County Text, max 60 characters  

PostCode Text, max 10 characters  

CountryCode Text, max 2 characters  

Contact Text, max 235 characters  

Telephone Text, max 30 characters  

Fax Text, max 30 characters  

Email Text, max 255 characters  

TaxNumber Text, max 60 characters  

TaxCode Integer  

TaxCountryCode Text, max 2 characters  
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6. Contact Us 

 

Eureka Solutions have worked successfully with many Sage 200 customers.  In addition to 

Data Exchange for Sage 200 and our other modules, we are also happy to engage in 

bespoke/customisation work to help tailor your Sage 200 system to meet your specific 

business requirements. 

 

We offer free trials of our Data Exchange for Sage 200 module available to download on our 

website www.eurekasolutions.co.uk.  For up to date information and details of all our addon 

modules for Sage 200, please refer to our website www.eurekaaddons.co.uk. Our bestselling 

addon modules include: 

 

 

Our Sales Order Plus module has been specifically 

designed to provide fast order entry from within Sage 

200 and aims to ensure that all information required by 

users entering orders is easily available from the main 

order entry screen. Sales Orders Plus has been really 

successful in telesales and tradecounter environments 

where fast order entry and access to sales history 

information is vital. 

  

The Web Purchase Orders for Sage 200 module has 

been created to allow users to enter purchase orders 

into Sage 200 via a web interface without the need to 

log into the Sage 200 system directly.  The module 

enables users to create purchase orders without taking 

up a full Sage 200 licence by utilising the Remote 

Access role in Sage 200. As a result it is ideal for 

companies with many users who enter purchase orders 

but don’t need access to other areas of Sage 200.   

 

 

Our Plus Pack is a collection of over 50 individual 

addons for Sage 200, most of which were created as a 

result of customer requests. The addons included in 

the pack range from simple sales order entry 

enhancements to some serious improvements to core 

Sage 200 functionality. 

 

If you wish to discuss a specific project or pricing or would like further information on Data 

Exchange or any of our addon modules for Sage 200 then please call our head office on 

01355 581 960 or e-mail us at development@eurekasolutions.co.uk.  

 


